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Disclaimer 

To the maximum extent permitted by applicable law, the products described (including its 

hardware, software and firmware, etc.) in this document are provided AS IS, which may have flaws, 

errors or faults. Yuejiang makes no warranties of any kind, express or implied, including but not 

limited to, merchantability, satisfaction of quality, fitness for a particular purpose and non-

infringement of third party rights. In no event will Yuejiang be liable for any special, incidental, 

consequential or indirect damages resulting from the use of our products and documents. 

Before using our product, please thoroughly read and understand the contents of this document 

and related technical documents that are published online, to ensure that the robotic arm is used on 

the premise of fully understanding the robotic arm and related knowledge. Please use this document 

with technical guidance from professionals. Even if follow this document or any other related 

instructions, Damages or losses will be happen in the using process, Dobot shall not be considered 

as a guarantee regarding to all security information contained in this document. 

The user has the responsibility to make sure following the relevant practical laws and 

regulations of the country, in order that there is no significant danger in the use of the robotic arm. 
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Preface 

Purpose 

This Document describes the functions, technical specifications, installation guide and system 

commissioning of Dobot Magician, making it easy for users to fully understand and use it. 

Intended Audience 

This document is intended for: 

 Customer Engineer 

 Sales Engineer 

 Installation and Commissioning Engineer 

 Technical Support Engineer 

Change History 

Date Change Description 

2018/06/12 The first release 

This release can only be used for Dobot Magician with a 0.0.0 hardware version 

 

Symbol Conventions 

The symbols that may be founded in this document are defined as follows. 

Symbol Description 

DANGER 

Indicates a hazard with a high level of risk which, if not 

avoided, could result in death or serious injury 

WARNING 

Indicates a hazard with a medium level or low level of 

risk which, if not avoided, could result in minor or 

moderate injury, robotic arm damage 

NOTICE 

Indicates a potentially hazardous situation which, if not 

avoided, can result in robotic arm damage, data loss, or 

unanticipated result 

NOTE Provides additional information to emphasize or 

supplement important points in the main text 
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 Security Precautions 

This topic describes the security precautions that should be noticed when using this product. 

Please read this document carefully before using the robotic arm for the first time. This product need 

to be carried out in an environment meeting design specifications, you cannot remold the product 

without authorization, otherwise it could lead to product failure, and even personal injury, electric 

shock, fire, etc. The installation personnel, operators, teaching personnel, and programmers of the 

robotic arm must read this document carefully and use the robotic arm strictly according to the 

regulations of this document strictly. 

1.1 General Security 

DANGER 

Robotic arm is an electrical equipment. Non-professional technicians cannot modify the 

wire, otherwise it is vulnerable to injury the device or the person. 

 

The following security rules should be followed when using the robotic arm. 

 You should comply with local laws and regulations when operating the robotic arm. The 

security precautions in this document are only supplemental to local laws and regulations. 

 The DANGER, WARNING, and NOTICE marks in this document are only 

supplemental to the security precautions. 

 Please use the robotic arm in the specified environment scope. If not, exceeding the 

specifications and load conditions will shorten the service life of the product even damage 

the equipment. 

 Before operating and maintaining the robotic arm, the personnel responsible for the 

installation, operation and maintenance must be trained to understand the various security 

precautions and to master the correct methods of operation and maintenance. 

 Highly corrosive cleaning is not suited to cleaning the robotic arm. The anodized 

components are not suitable for immersion cleaning. 

 People cannot repair and disassemble the robotic arm without professional training. If 

there is a problem with the robotic arm, please contact Dobot technical support engineer 

in time. 

 Please comply with the relevant laws to deal with the product which is scrapped, and 

protect the environment. 

 There are small parts in the packing box, Please keep them away from children, to avoid 

any accidents. 

 DO NOT let children play with the robotic arm alone. All processes need to be monitored 

while running. After processes have finished, please turn off the equipment promptly. 

 DO NOT put hands into the workspace of the robotic arm while running, to avoid bruising 

or pinching. 

 Be careful during the robotic arm carrying or installing. Please follow the instructions on 
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the packing box to put down the robotic arm gently and place it correctly in direction of 

arrow. 

 It is prohibited to modify or remove the nameplates, instructions, icons and marks on the 

robotic arm and the related equipment. 

 Please refer to Dobot Magician User Guide along with the packing box before using. 

 Precautions 

 Please make the Dobot Magician in the workspace with a 45° angle between the Forearm 

and Rear Arm (as shown in Figure 1.1) before starting up. If the LED indicator turns red 

after starting up, it indicates that the Dobot Magician is at a limited position. Please make 

the Dobot Magician in the workspace. 

 

Figure 1.1  The Forearm and Rear Arm position 

 

 Dobot Magician will move slowly to the specific position when shutdown. DO NOT put 

hands into the workspace of the Dobot while running, to avoid bruising or pinching. Only 

once the LED indicator completely turns off, the Dobot Magician can be powered down. 

 If the coordinates of the Dobot Magician shown on the DobotStudio are abnormal, please 

press the Reset button on the back of the base to reset Dobot Magician or click Home on 

the DobotStudio page to perform homing.  

 During resetting, Dobot Magician will disconnect from the PC automatically and the 

LED indicator on the base turns yellow. About 5 seconds later, if the LED indicator 

turns green, it indicates that the reset is successful.  

 During homing, Dobot Magician will rotate clockwise to the limited position and 

then return to the homing point automatically, and the LED indicator on the base 

turns blue and is blinking. After homing, if there is a beep sound and the LED 

indicator turns green, it indicates that the homing is successful. 

 Please turn off the Dobot Magician completely first before connecting or disconnecting 

external equipment, such as Bluetooth, WIFI, stick controller, infrared sensor, color 

sensor, etc. Or, it causes damage to your device. 

 Please wear the lasing protective eyeglass when using the laser module. Please protect 

your eyes and skin from the laser. 

 The heating rod will produce high temperature up to 250℃ when using the 3D printing 
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module, please be careful. 

 Please DO NOT operate or turn off Dobot Magician when burning firmware, to avoid 

machine damage. 

 

 Important Safety Notice  

 Small spare parts are included, so please keep them away from children, as they are a 

choking hazard. 

 DO NOT let children play with the Dobot alone. All processes need to be monitored while 

running. After processes have finished, please turn off the equipment promptly. 

 While using the laser module, please wear protective glasses. Avoid eye or skin exposure 

to direct radiation. Keep a safe distance from the laser to avoid accidental injury. 

 When using the 3D printing module, the heating rod will produce temperatures up to 

250℃, please be careful! 

 DO NOT put hands into the operating zone while the Dobot is running. Not doing so runs 

the risk of bruising and/or pinching. 

 Only trained and trained personnel may commission and set up Dobot. 

 Dobot may only be operated with the associated standard equipment. Any other use of 

tools is deemed to be inaccurate use. 

 Only authorized personnel who are instructed in work safety must work on the machine. 

 Suitable personal protective equipment wear protective clothing (gloves, safety shoes …). 

 General work safety must be observed. 

 Only trained and trained personnel may carry out maintenance work on Dobot. 
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 Quick Start 

This topic briefly describes how to operate the Dobot Magician with the software DobotStudio, 

allowing you to quickly know and use the robotic arm. Figure 2.1 shows the process of getting 

started with the Dobot Magician. 

 

Figure 2.1  The process of getting started with the Dobot Magician 

 

 Connecting Cables to the Dobot Magician 

 Connect the Dobot Magician to your computer with the supplied USB cable, as 

shown in Figure 2.2. 
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Figure 2.2  Connect the Dobot Magician to your computer 

 

 Connect the Dobot Magician to the electrical outlet with the supplied power adapter, 

as shown in Figure 2.3. 

  

Figure 2.3  Connect the Dobot Magician to the electrical outlet 

 

 Installing the DobotStudio 

With the DobotStudio, you can control Dobot Magician to implement functions such as 

Teaching & Playback, fully programmable applications, and 3D printing. This topic introduces 

Teaching & Playback. 

 System Requirements 

The DobotStudio supports the following Windows and macOS versions. 

 Windows 7, Windows 8, and Windows 10 (This manual is explained based on this version) 

 macOS 10.10, macOS 10.11, and macOS 10.12 
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 Obtaining the DobotStudio Package 

Before using Dobot Magician, download the Windows DobotStudio package from 

https://www.dobot.cc/downloadcenter.html. The macOS version is also downloadable in this URL. 

 Installing the DobotStudio 

Prerequisites 

The DobotStudio package has been obtained. 

Procedure 

 Unpack the DobotStudio package to a destination directory. 

For example, this directory is Installation Directory\DobotStudio. You can install 

the DobotStudio to another location based on site requirements. 

 In the installation directory double-click DobotStudioSetup.exe. The Select Setup 

Language dialog box is displayed, as shown in Figure 2.4. 

 

Figure 2.4  The Select Setup Language dialog box 

 

 Choose a setup language such as English, as shown in Figure 2.5. You can also select 

Chinese if needed. 

 

Figure 2.5  Select English 

 

 Click OK to follow the on-screen instructions to continue with the installation. 

During the installation, the DriverSetup(X64) dialog box is displayed, as shown in 

Figure 2.6. 

https://www.dobot.cc/downloadcenter.html
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Figure 2.6 The DriverSetup(X64) dialog box 

 

 Click INSTALL to install the Dobot Magician driver. 

When the driver is installed successfully, the The drive is successfully Pre-installed 

in advance! dialog box is displayed, as shown in Figure 2.7. 

 

Figure 2.7  The drive is successfully Pre-installed in advance! dialog box  

 

 Click OK. 

 Click Next to continue to install the DobotStudio by following the prompts on the 

Setup – DobotStudio dialog box.  

When the installation is complete, the Completing the DobotStudio Setup Wizard 

dialog box is displayed, as shown in Figure 2.8. 

 

Figure 2.8  The Completing the DobotStudio Setup Wizard dialog box 
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 Click Finish. 

 Verifying the Installation 

2.2.4.1 Verifying the DobotStudio 

If the DobotStudio is launched and runs properly by double-clicking the desktop shortcut to 

this program, it means that it is installed successfully. 

2.2.4.2 Verifying the Dobot Magician Driver 

If an available COM port is displayed on the upper left corner of the DobotStudio page after 

the robotic arm is powered on, as shown in Figure 2.9, the Dobot Magician driver is installed 

successfully. 

 

Figure 2.9  An available COM port is displayed 

 

If no COM port is available, check whether the robotic arm driver is successfully installed by 

following the steps below. 

 Connect the Dobot Magician to your computer with the supplied USB cable. 

 Press the power button to apply power. 

 Launch the Device Manager window to locate the Ports (COM & LPT) section. If 

the item USB-SERIAL CH340 (COM3) is displayed, it means the Dobot Magician 

driver is installed successfully. 

 

Figure 2.10  The robotic arm driver in Device Manager window 
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NOTE 

To reinstall the Dobot Magician driver after uninstalling it, double-click SETUP.EXE to 

install the driver in the directory Installation 

Directory\DobotStudio\attachment\CH341SER_WIN\CH341SER, as shown in 

Figure 2.11. 

 

 

Figure 2.11  Install the Dobot Magician driver 

 

 Powering On/Off the Dobot Magician 

 Power on: align the Dobot Magician into its neutral position with its Forearm and Rear 

Arm constructing a 45-degree angle, and press down the power button in the base, as 

shown in Figure 2.12. Once the robotic arm is powered on, the LED indicator turns yellow, 

and all the stepper motors lock. And then wait about seven seconds, a short beep sound 

will be heard, and the LED indicator turns from yellow to green. Now the Dobot Magician 

is ready to use. 

 

NOTICE 

If the LED indicator is red after powering on the Dobot Magician, it means that the 

robotic arm reaches its limited position. To go back to the workspace, press and hold the 

unlock button  on the Forearm to move the robotic arm to another desired position 

After releasing the button the LED indicator turns green. 
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Figure 2.12  The gesture of Dobot Magician before power-on 

 

 Power off: When the LED indicator is green, press down the power button to turn off the 

robotic arm. In this case, the Forearm moves slowly to the Rear Arm while the angle 

between them becomes small. Finally, the two arms reach a specific position. 

 

WARNING 

During the shutdown process, watch your hand. 

 

 Getting Started 

This topic describes how to use the Dobot Magician to complete the teaching & playback 

function by saving three points in the MOVJ mode, allowing you to get the basic knowledge of the 

usage of the robotic arm. 

Prerequisites 

 The DobotStudio has been installed. For details, see 2.2 Installing the DobotStudio. 

 The Dobot Magician is powered on. For details, see 2.3 Powering On/Off the Dobot 

Magician. 

Procedure 

 Double-click the desktop shortcut to the DobotStudio. 

The DobotStudio page with its beginner guide is displayed, as shown in Figure 2.13. 

 



                     Dobot Magician User Guide 2 Quick Start 

Issue V1.0 (2018-06-12) User Guide Copyright © Yuejiang Technology Co., Ltd. 

 11  

 

Figure 2.13  The DobotStudio page with a beginner guide 

 

 Click Connect on the DobotStudio page, as shown in Figure 2.14. 

The Question dialog box is displayed, as shown in Figure 2.15. 

 

Figure 2.14  Click Connect 

 

 

Figure 2.15  The Question dialog box 
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 Click OK. 

Because this section is for quick access to the Dobot Magician only and no high 

accuracy is required.  

When Connect changes to Disconnect, it means that the DobotStudio is connected 

the Dobot Magician, as shown in Figure 2.16. 

 

NOTE 

To achieve a high accuracy of the robotic arm, click Cancel, and wait 7.53 seconds, and 

then click Connect again. The time duration is for reference only. For the exact time, see 

the message from the Question dialog box. 

 

 

Figure 2.16  The DobotStudio is connected to the Dobot Magician 

 

 Use DobotStudio to accomplish a teaching & playback task. 

 Click Teaching & Playback, as shown in Figure 2.17. 
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Figure 2.17  Click Teaching & Playback 

 

NOTE 

After reading a beginner guide on the Teaching & Playback page, as shown in Figure 

2.18, click  to close it. 

 

 

Figure 2.18  Teaching & Playback page 

 

 Select PTP Point > MOVJ mode in the Save Point area, as shown in Figure 

2.19. 
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Figure 2.19  Select MOVJ motion mode 

 

 Press and hold the unlock button  on the Forearm to move the robotic arm 

to a position such as point A, and then release the button. 

In this case, the DobotStudio will save the Cartesian coordinate of point A, as 

shown in Figure 2.20. 

 

Figure 2.20  The Cartesian coordinate of point A 

 

NOTE 

Apart from hand-guided teaching, you can accomplish a teaching task by jogging the 

Dobot Magician in the Cartesian or Joint coordinate system, as shown in Figure 2.21. 
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Figure 2.21  Jog the Dobot Magician in the Cartesian or Joint coordinate system 

 

 Move the robotic arm to other two locations such as points B and C by referring 

to the method of creating point A above, as shown in Figure 2.22. The robotic 

arm will save the Cartesian coordinates corresponding to these two points. 

 

 

Figure 2.22  The Cartesian coordinates of points B and C 

 

 Enter 3 in Loop text box.  

The robotic arm will repeat the sequence of movements for three times, as 

shown in Figure 2.23. 
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Figure 2.23  Enter 3 in the Loop text box 

 

 Click Start to perform the motions taught above, as shown in Figure 2.24. 

The robotic arm will stop after playing back the steps for three times. 

 

Figure 2.24  Click Start 

 

 Click  to exit the Teaching & Playback page, as shown in Figure 2.25. 
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Figure 2.25  Click Exit 



                     Dobot Magician User Guide 3 Introduction 

Issue V1.0 (2018-06-12) User Guide Copyright © Yuejiang Technology Co., Ltd. 

 18  

 Introduction 

 Overview 

Dobot Magician is a multifunctional desktop robotic arm for practical training education, 

supporting teaching and playback, blockly graphic programming, script, etc. Installed with different 

end-effectors, Dobot Magician can realize interesting functions such as 3D printing, laser engraving, 

writing and drawing. It also supports secondary development by various extensible I/O interfaces, 

which really makes your creativity and imagination increase without any limitation. 

 Appearance and Constitute 

Dobot Magician consists of Abase, Rear Arm, Forearm, and end-effector, etc. Figure 3.1 shows 

the appearance. 

 

Figure 3.1  The appearance of Dobot Magician 

 

 Working Principle 

This topic describes the workspace, principle, size and technical specifications of Dobot 

Magician. 

 Workspace 

Figure 3.2 and Figure 3.3 shows the workspace. 
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Figure 3.2  Workspace of Dobot Magician (1) 

 

 

Figure 3.3  Workspace of Dobot Magician (2) 
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 Coordinate System 

Dobot Magician has two types of coordinate system, the joint one and the Cartesian one, as 

shown in Figure 3.4 and Figure 3.5 respectively. 

 

Figure 3.4  Joint coordinate system 

 

 

Figure 3.5  Cartesian coordinate system 

 

 Joint coordinate system: The coordinates are determined by the motion joints. 

 If the end-effector is not installed, Dobot Magician contains three joints: J1, J2, and 

J3, which are all the rotating joints. The positive direction of these joints is counter-

clockwise. 

 If the end-effector with servo is installed, such as suction cup kit, gripper kit, Dobot 

Magician contains four joints: J1, J2, J3 and J4, which are all the rotating joints. The 

positive direction of these joints is counter-clockwise. 

 Cartesian coordinate system: The coordinates are determined by the base. 

 The origin is the center of the three motors (Rear Arm, Forearm, base). 

 The direction of X-axis is perpendicular to the base forward. 
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 The direction of Y-axis is perpendicular to the base leftward. 

 The direction of Z-axis is vertical upward, which is based on the right hand rule. 

 The R-axis is the attitude of the servo center relative to the origin of the robotic arm, 

of which the positive direction is counter-clockwise. The R-axis only exists once the 

end-effector with servo is installed. 

 Motion Function 

The motion modes of Dobot Magician include Jogging, Point to Point (PTP), ARC. 

3.3.3.1 Jogging Mode 

Jogging mode is the mode jogging Dobot Magician along the Cartesian coordinate system or 

Joint coordinate system when teaching. 

NOTE 

This topic describes jogging mode by the GUI operation of DobotStudio. 

 

 Cartesian coordinate system mode 

 Click X+, X- and Dobot Magician will move along X-axis in the negative or positive 

direction. 

 Click Y+, Y- and Dobot Magician will move along Y-axis in the negative or positive 

direction. 

 Click Z+, Z- and Dobot Magician will move along Z-axis in the negative or positive 

direction. 

 Click R+, R- and Dobot Magician will rotate along R-axis in the positive or negative 

direction. 

NOTICE 

If the end-effector with servo is installed on the Dobot Magician, the R-axis will move 

together with Y-axis, to make sure that the terminal posture relative to the origin stays 

constant. 

 

 Joint coordinate system mode 

 Click J1+, J1- and control the base motor to rotate in the negative or positive 

direction. 

 Click J2+, J2- and control the Rear Arm motor to rotate in the negative or positive 

direction. 

 Click J3+, J3- and control the Forearm motor to rotate in the negative or positive 

direction. 

 Click J4+, J4- and control the servo to rotate in the negative or positive direction. 

3.3.3.2 Point to Point (PTP) 

PTP mode supports MOVJ, MOVL, and JUMP, which means point to point movement. The 

trajectory of playback depends on the motion mode. 
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 MOVJ: Joint movement. From point A to point B, each joint will run from initial angle to 

its target angle, regardless of the trajectory, as shown in Figure 3.6. 

 

Figure 3.6  MOVL/MOVJ mode 

 

 MOVL: Rectilinear movement. The joints will perform a straight line trajectory from 

point A to point B, as shown in Figure 3.6. 

 JUMP: From point A to point B, the joints will move in MOVJ mode, of which the 

trajectory looks like a door, as shown in Figure 3.7. 

 ssMove up the lifting Height in MOVJ mode. 

 Move horizontally to a point that is above B by height. 

 Move down to point B. 

 

Figure 3.7  JUMP mode 

 

3.3.3.3 ARC 

The trajectory of ARC mode is an arc, which is determined by three points (the current point, 

any point and the end point on the arc), as shown in Figure 3.8.  

NOTICE 

In ARC mode, it is necessary to confirm the three points with other motion modes, and 

the three points cannot be in a line. 
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Figure 3.8  ARC mode 

 

3.3.3.4 Application Scenarios 

The application scenario depends on the trajectory in motion mode, as shown in Table 3.1. 

Table 3.1  Application scenario 

Motion mode Application scenario 

MOVL If the trajectory of playback is required as a straight 

line, you can choose MOVL 

MOVJ If the trajectory of playback is not required but high 

speed is required, you can choose MOVJ 

JUMP If the movement of two points is required to lift 

upwards by amount of height, such as sucking up, 

grabbing, you can choose JUMP 

ARC If the trajectory of playback is required as an arc, such 

as dispensing, you can choose ARC 

 

 Technical Specifications 

 Technical Parameters 

Name  Dobot Magician 

Maximum 

payload 

500g 

Maximum reach 320mm 

Motion range Base ﹣90°-90° 

Rear Arm 0°-85° 

Forearm ﹣10°-90° 

End-effector 

rotation 

﹣135°-135° 
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Maximum speed 

(with 250g 

payload) 

Rotational 

speed of 

Rear arm, 

Forearm and 

base 

320°/s 

Rotational 

speed of 

servo 

480°/s 

Repeated 

positioning 

accuracy 

0.2mm 

Power supply 100V-240V AC, 50/60Hz 

Power in 12V/7A DC 

Communication USB, WIFI, Bluetooth 

I/O 20 extensible I/O interfaces 

Software DobotStudio 

Working 

temperature 

-10°-60° 

 

 Sizes 

Figure 3.9 shows the size of Dobot Magician and Figure 3.10 shows the size of the end 

mounting hole. 
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Figure 3.9  Size of Dobot Magician 

 

 

Figure 3.10  Size of end mounting hole 
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 Interface Description 

 Interface Board 

The interfaces of Dobot Magician are located on the back of the base and the Forearm 

respectively. Figure 4.1 shows the interfaces on the back of the base, and Table 4.1 lists the 

description. 

 

Figure 4.1  Interfaces in the base 

 

Table 4.1 Interface Description 

No. Description 

1 Reset key: Reset MCU program 

During resetting, the LED indicator on the base turns yellow. About 5 seconds 

later, if the LED indicator turns green, it indicates that the reset is successful 

2 Functional key: 

 Short press: Start running offline program 

 Long press for 2 seconds: Starting homing procedure 

3 Communication interface/UART interface: Connect with Bluetooth, WIFI and 

so on 

The Dobot protocol is adopted. 

4 USB interface: Connect with PC 

5 Power interface: Connect with power adaptor 

6 Peripheral interface: Connect with air pump, extruder, sensor and other 

peripheral equipment. For details about peripheral interfaces, please see Table 

4.2 

 

Table 4.2 lists the peripheral interface description. 
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Table 4.2  Peripheral interface description 

Interface Description 

SW1 Power interface of air pump; output 12V of controllable power 

SW2 Output 12V of controllable power 

Stepper1 User-defined stepper interface; extruder interface (3D printing mode) 

Stepper2 User-defined stepper interface 

GP1 Signal interface of air pump; color sensor interface; infrared sensor interface; 

user-defined general interface 

GP2 Color sensor interface; infrared sensor interface; user-defined general interface 

 

Figure 4.2 shows the peripheral interface on the Forearm, and Table 4.3 lists the description of 

the peripheral interfaces. 

 

Figure 4.2  Peripheral interface in the Forearm 

 

Table 4.3  Peripheral interface description 

No. Description 

1 GP3, Auto levelling interface, R-axis servo interface; infrared sensor interface; 

user-defined general interface 

2 GP4, user-defined general interface; color sensor interface; infrared sensor 

interface 

3 GP5, Signal interface of laser engraving; color sensor interface; infrared sensor 

interface; user-defined general interface 

4 SW3, Hot end interface (3D printing mode); Output 12V of controllable power 

5 SW4, Fan interface (3D printing mode); Power interface of laser engraving; 

Output 12V of controllable power 

6 ANALOG, Thermistor interface (3D printing mode) 
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 LED Indicator 

The LED indicator is located on the base, Table 4.4 lists the status description. 

Table 4.4  LED indicator description 

Status Description 

Green On Dobot Magician works normally 

Yellow On  Dobot Magician is in the starting status 

 The power adapter is not connected firmly 

Blue On Dobot Magician is in the offline mode 

Blue Blinking Dobot Magician is running homing procedure or auto levelling 

Red On  Dobot Magician is at the limited position 

 Alarm is not cleared 

 Connection of 3D printing kit is abnormal 

 

 Multiplexed I/O Interface Description 

The addresses of the I/O interfaces in Dobot Magician are unified. Most of I/O interfaces have 

multiple functions, to control the peripheral equipment. 

 Multiplexed Base I/O Interface Description 

4.3.1.1 Multiplexed UART Interface Description 

Figure 4.3 shows the UART interface on the base, Table 4.5 lists the multiplexed I/O 

description. 

 

Figure 4.3  UART interface 
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Table 4.5  Multiplex I/O Description 

I/O addressing Voltage Level Output PWM Level Input ADC 

18 3.3V √ - √ - 

19 3.3V √ - √ - 

20 3.3V √ - √ - 

 

4.3.1.2 Multiplexed Peripheral Interface Description  

Figure 4.4 shows the peripheral interface on the base, and Table 4.6 lists the multiplexed I/O 

description. 

 

Figure 4.4  Peripheral Interface 

 

Table 4.6  Multiplexed I/O Description 

I/O addressing Voltage Level Output PWM Level Input ADC 

10 5V √ - - - 

11 3.3V √ √ √ - 

12 3.3V √ - √ √ 

13 5V √ - - - 

14 3.3V √ √ √ - 

15 3.3V √ - √ √ 

16 12V √ - - - 

17 12V √ - - - 
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 Multiplexed Forearm I/O Interface Description 

Figure 4.5 shows the peripheral interface on the Forearm, Table 4.7 lists the multiplexed I/O 

description. 

 

Figure 4.5  Peripheral interface in the Forearm 

 

Table 4.7  Multiplexed I/O description 

I/O addressing Voltage Level Output PWM Level Input ADC 

1 3.3V √ - √ √ 

2 12V √ - - - 

3 12V √ - - - 

4 3.3V √ √ √ - 

5 3.3V √ - √ √ 

6 3.3V √ √ √ - 

7 3.3V √ - √ √ 

8 3.3V √ √ √ - 

9 3.3V  √ - √ √ 
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 Operation 

 Introduction to the DobotStudio 

 Function Modules 

You can use the DobotStudio to control the Dobot Magician to accomplish multiple functions 

such as Teaching & Playback, Write & Draw, Blockly graphic programming, and Script control, 

as shown in Figure 5.1. For details, see Table 5.1.  

 

Figure 5.1  The function modules on the DobotStudio page 

 

Table 5.1  The function modules on the DobotStudio page 

Function Modules Description 

Teaching & Playback Teach the Dobot Magician how to move and then record the movement to 

make Dobot Magician accomplish the recorded movements. 

Write & Draw Control the robotic arm to write, draw, or engrave an object using a laser.  

Blockly Use Blockly to program the robotic arm in a graphic programming 

environment. It allows the users to drag and drop the blocks onto a workplace 

to generate execute code just as intuitive and easy as a block puzzle. 

Script Control the robotic arm using the script commands. 

Leap Motion Support hand motions as input to control the robotic arm via a Leap Motion 

controller. 

Mouse Control the robotic arm using a mouse. 

LaserEngraving Engrave a bitmap image on an object using a laser. 

3DPrinter Capable of 3D printing 
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Function Modules Description 

Add More Add more custom functions to manipulate the robotic arm. 

 

You can also set the Dobot Magician by clicking Setting on the DobotStudio page, for example, 

implement general settings, base calibration, manual levelling, and auto levelling, as shown in 

Figure 5.2. For details, see Table 5.2. 

 

Figure 5.2  The General Setting page 

 

Table 5.2  The General Setting page 

Items Description 

Firmware Switch firmware 

For example, you can switch to the 3D printer firmware to implement 3D 

printing from the currently selected Dobot firmware 

Sensor and Base Set the Base Encoder and the angle sensors on the Forearm and Rear Arm 

Base Calibration Calibrate the base Encoder 

Manual Levelling Manually calibrate the angle sensors on the Forearm and Rear Arm 

Auto Levelling Automatically calibrate the angle sensors on the Forearm and Rear Arm. 

Initial Pos Set the initial pose of the robotic arm. 
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Items Description 

Jog Set the jogging speed and acceleration in the Joint coordinate system and 

Cartesian coordinate system 

Playback Set the joint parameters, coordinate parameters, Jump parameters, handhold 

teaching and LostStepParam. 

Write Draw Set the Write & Draw function, such as speed, Junction velocity, linear 

acceleration, acceleration, pen up offset and pen down position. 

Leap Motion Set the parameters such as speed, scale, and performance for hand gesture 

control. 

Mouse Set the parameters such as speed, scale, and performance for mouse control. 

LaserEngraving Set the parameters such as junction velocity, linear acceleration, acceleration, 

pen down position, and DPI for laser engraving. 

 

 Common Areas of DobotStudio Page 

The DobotStudio offers the following common areas shared by all the function modules to 

control the robotic arm. 

 You can select the liner rail or an end-effector on the DobotStudio page, as shown in 

Figure 5.3. 

 

Figure 5.3  The linear rail and end-effector drop-down list 

 

Table 5.3  The linear rail and end-effector drop-down list 

Items Description 

Linear rail When the robotic arm is connected to a linear rail, click this item to enable the rail 

End-effector  

drop-down list 

When the end-effector is a suction cup kit, gripper kit, laser kit or writing kit, select the 

corresponding kit in this list 

 

 You can also perform other operations on the DobotStudio page such as Setting, Home, 

Emergency Stop, and viewing the versions, as shown in Figure 5.4. 

 

Figure 5.4  Setting, Home, Emergency Stop, and viewing the versions 
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Table 5.4  Setting, Home, Emergency Stop, and viewing the versions 

Items Description 

Setting 
Set the robotic arm such as firmware upgrade, sensor and base setup. For details, see 

Table 5.2 

Home 

Set the Dobot Magician back to its home position to get a correct reference position 

When the Dobot Magician is moving, if its movement is hindered by an obstacle or the 

stepper motors lost steps, perform the homing operation 

Emergency Stop Stop the robotic arm if an emergency occurs 

 
View the version information such as DobotStudio version, firmware version, and 

hardware version 

 

With the Operation Panel on the DobotStudio page, you can teach the robotic arm to perform 

a specific task such as jogging the robotic arm in the Cartesian or joint coordinate system, or 

controlling a gripper, suction cup, or laser, as shown in Figure 5.5. For details, see Table 5.5.  

 

Figure 5.5  Setting the Operation Panel 

 

Table 5.5  Setting the Operation Panel 

Items Description 

Coordinate 

jogging 

Jog the Dobot Magician by clicking X (X+/-), Y (Y+/-), Z (Z+/-), or R (R+/-) in the 

Cartesian coordinate system 
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Items Description 

Joint jogging 
Jog the Dobot Magician by clicking J1+/-, J2+/-, J3+/-, or J4+/- in the Joint coordinate 

system 

Linear control 

When the linear rail is enabled (see Table 5.3), click L+/- to move the robotic arm along 

the rail. 

Value range: 0 mm - 1000 mm 

Gripper control 
When the end-effector is chosen as a Gripper, you can set the gripper to open, close, or 

disable in the Gripper drop-down box 

Suction cup 

control 

When the end-effector is chosen as a Suction Cup, select SuctionCup to power on the air 

pump. If unselected, the air pump is powered off 

Laser control 
When the end-effector is chosen as a Laser, select Laser to turn on the laser. If 

unselected, the laser is turned off 

Jogging speed 

control 

Set the jogging speed percentage 

Default value: 50%  

Value range: 1% - 100% 

 

 Performing Teaching & Playback Tasks 

This topic introduces how to perform a teaching & playback task to suck or grab a small cube. 

Because a suction cup kit or a gripper kit is required, we will explain them first. 

 Installing a Suction Cup Kit 

A suction cup kit is the default end-effector shipped with the Dobot Magician. When using the 

suction cup kit, an air pump is necessary, as shown in Figure 5.6.  

 

Figure 5.6  A suction cup kit 

 

Procedure 

 Connect the air pump’s power cable SW1 to the SW1 connector on the Dobot 

Magician base’ rear panel and the signal cable GP1 to the GP1 connector, as shown 

in Figure 5.7. 
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Figure 5.7  Connect the air pump to the Dobot Magician 

 

 Insert a suction cup kit into the end’s port, and fasten it with a butterfly nut, as shown 

in Figure 5.8. 

 

Figure 5.8  Install a suction cup kit 

 

 Connect the air pump’s air tube to the air tube connector of the suction cup kit, as 

shown in Figure 5.9. 
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Figure 5.9  Install an air tube 

 

 Connect the servo’s GP3 cable to the GP3 connector on the Forearm, as shown in 

Figure 5.10. 



                     Dobot Magician User Guide 5 Operation 

Issue V1.0 (2018-06-12) User Guide Copyright © Yuejiang Technology Co., Ltd. 

 38  

 

Figure 5.10  Connect the servo’s GP3 cable to the GP3 connector 

 

 Installing a Gripper Kit 

An air pump should be used with the gripper kit, as shown in Figure 5.11, to open or close the 

gripper. 

 

Figure 5.11  A gripper kit 
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Procedure 

 Dismantle the suction cup by unfastening its terminal strand with a 1.5mm hexagon 

wrench, as shown in Figure 5.12. 

 

Figure 5.12  Dismantle the suction cup 

 

 Install a gripper kit to the servo with a 2.5mm hexagon wrench, as shown in Figure 

5.13. 

 

Figure 5.13  Install a gripper kit 

 

 Connect the gripper kit and an air pump to the Dobot Magician in the same way as 

the suction cup kit is installed. For details, see 5.2.1 Installing a Suction Cup Kit. 

Figure 5.14 shows the effect of the gripper kit installation. 
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Figure 5.14  The effect of the gripper kit installation 

 

 Teaching & Playback Page 

The Teaching & Playback page is shown in Figure 5.15. To access it, select Connect > 

Teaching & Playback on the DobotStudio page. 

 

Figure 5.15  The Teaching & Playback page 

 

 In both Easy and Pro modes, you can switch between Easy and Pro modes, set loop, 

speed percentage, and acceleration percentage, as shown in Figure 5.16. 

 

Figure 5.16  Set Easy/Pro, Loop, Speed and Acceleration (Acc) 
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Table 5.6  Set Easy/Pro, Loop, Speed and acceleration (Acc) 

Items Description 

Easy/Pro 

Click this slider to switch between Easy and Pro modes. The default is the Easy mode. 

Apart from all the functions in the Easy mode, the Pro mode offers multiple features such 

as the offline mode and multiplexed I/O interface. 

Loop 

Set the loop that the robotic arm plays back the recorded steps. 

Default value: 1 

Value range: 1 - 999999 

Speed 

Set the speed ratio when doing playback. 

Default value: 50% 

Value range: 0% - 100% 

acceleration 

(Acc) 

Set the acceleration ratio when doing playback. 

Default value: 50% 

Value range: 0 - 100% 

Exit Exit the current Teaching & Playback page to return to the DobotStudio page 

 

 In both Easy and Pro modes, you can save points, set the motion mode and the pause time 

for a save point, as shown in Figure 5.17. 

 

Figure 5.17  Set the save points, motion modes and pause time 

 

Table 5.7  Set the save points, motion modes, and pause time 

Items Description 

+Point Click to create a new save point in the Save points list 

Motion mode 

Choose a PTP (point to point) Point mode or ARC Point mode. In the PTP Point mode, 

you can select MOVJ, MOVL, or JUMP mode while the ARC Point mode requires a 

second point cirPoint and a finish point toPoint as well as the start point set via the PTP 

Point mode 
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Items Description 

Pause time Set the pause time for a save point 

 

 In both Easy and Pro modes, you can edit a highlighted save point such as copy, paste, 

cut, switch between motion modes, modify name and coordinates, as shown in Figure 

5.18. 

 

Figure 5.18  The Save points list 

 

Table 5.8  The Save points list 

Items Description 

A right-click mouse 

operation 

In the right-click popup menu you can edit a highlighted save point such as copy, 

paste, cut, insert, and delete, as shown in Figure 5.18 

A double-click mouse 

operation 

Double-clicking a cell to modify its value 

 

 Pro mode: To enter the Pro mode from the current Easy mode, click the Easy/Pro slider, 

as shown in Figure 5.19. Apart from all the functions in the default Easy mode, the Pro 

mode allows the robotic arm to run a save point each time, detect lost-steps, work in 

offline mode, and perform the multiplexed I/O interface. For details, see Table 5.9. 
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Figure 5.19  The Pro mode of the Teaching & Playback function 

 

Table 5.9  The Pro mode of the Teaching & Playback function 

No. Description 

1 
StepRun: run a save point each time in the Save points list. Before clicking StepRun, please select 

a saved point.  

2 
Download: download the Save points list to the Dobot Magician for working in offline mode. For 

details, see 5.3 Working in Offline Mode 

3 

Check Lost Step: the Dobot Magician detects if lost-steps occur in its movements. The default 

threshold is 5 degrees. It should be at least 0.5 degrees. You can set the threshold by selecting 

Setting > Playback > LostStepParam. 

If Check Lost Step is selected, the robotic arm detects if the stepper motors lose steps when 

moving. If unselected, no detection is performed 

If the Dobot Magician detects lost-steps, it stops working, and its LED indicator turns red. In this 

case, click Home to get a correct reference position 

4 
Multiplexed I/O interface: control the Dobot Magician via the I/O interfaces such as turning on or 

off the air pump 

 

 ARC Motion Mode 

Application Scenarios 

The ARC motion mode requires three points in an arc to complete the arc movement process. 

In the ARC motion mode, only the second point and end point are saved while the start point is 

determined by the other modes. 

Prerequisites 

The Dobot Magician has been powered on and connected to your computer. 
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Procedure 

NOTICE 

Note the following rules when saving points to prevent the robotic arm from working 

outside its normal workspace. 

 Any two points cannot coincide.  

 The three points cannot be in the same straight line. 

 The arc trajectory cannot exceed the Dobot Magician’s normal workspace. 

 

For example the points A, B, and C are on the arc. Point A is the start point; Point B is the 

second point; Point C is the end point, as shown in Figure 5.20. 

 

Figure 5.20  The arc trajectory 

 

 Click Teaching & Playback. 

The Teaching & Playback page is displayed. 

 Save the start point A. 

 Select MOVJ motion mode in the Save Point area. 

 Click  to display the Operation Panel, as shown in Figure 5.21. 

 

Figure 5.21  Display the Operation Panel 
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 Set the jogging speed percentage to 50 on the Operation Panel. 

 Jog the Dobot Magician in the Cartesian or Joint coordinate system to move the 

robotic arm to a location called position A. 

 Click +Point to save the coordinate corresponding to the position A, as shown 

in Figure 5.22. 

 

Figure 5.22  Save the start position A 

 

 Save the second point B and the end point C. 

 Select cirPoint to save the second point in the Save Point area. 

 Jogging the Dobot Magician in the Cartesian or Joint coordinate system to move 

the robotic arm to the second position B as required. 

 Click +Point to save the coordinate corresponding to the position B. In this 

case, the DobotStudio automatically changes the motion mode to toPoint to get 

ready to save the end position. 

 Jogging the Dobot Magician in the Cartesian or Joint coordinate system to move 

the robotic arm to the end position C as needed. 

 Click +Point to save the coordinates corresponding to the positions B and C, as 

shown in Figure 5.23. 
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Figure 5.23  Save the second position B and the end position C 

 

 Set the percentage of both speed and acceleration for playback, for example 50. 

 Set Loop to 2. 

 Click Start. The Dobot Magicin perfrom the sequence of ARC trajectory as taught 

from its memory system, moving from positions A through C, as shown in . 

 

Figure 5.24  Move the small cube in the ARC motion mode 

 

 Teaching & Playback Example 

Application Scenarios 

You can use Teaching & Playback function module to manipulate the Dobot Magician to 

accomplish different tasks such as transportation or intelligent sort. This topic introduces how to 

move small cubes from position A to B in the JUMP motion mode. 

Prerequisites 

 The Dobot Magician has been powered on and connected to your computer. 
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 A suction cup kit has been installed. For details, see 5.2.1 Installing a Suction Cup Kit. 

Procedure 

 Choose SuctionCup as the end-effector on the DobotStudio page, as shown in 

Figure 5.25. 

 

Figure 5.25  Choose SuctionCup as the end-effector 

 

 Click Teaching & Playback. 

The Teaching & Playback page is displayed. 

NOTE 

After reading the beginner guide of the DobotStudio, click  to close it. 

 

 Save the start point A. 

 Put a small cube on the work surface near the suction cup kit. 

 Select the MOVJ motion mode in the Save Point area. 

 Click  to display the Operation Panel, as shown in Figure 5.26. 
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Figure 5.26  Display the Operation Panel 

 

 Set the jogging speed percentage to 50 on the Operation Panel. 

NOTE 

To change the jogging speed, select Setting > Jog to set the speed and acceleration of the 

joints, linear rail, or the Cartesian coordinate system, as shown in Figure 5.27. 

 

 

Figure 5.27  Adjust the jogging speed 
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NOTICE 

Regarding the jogging speed and acceleration in the Joint coordinate system and 

Cartesian coordinate system, we recommend that it should be less than 500mm/s if loaded 

and that less than 800mm/s if not loaded. 

 

 Jog the Dobot Magician in the Cartesian or Joint coordinate system to move the 

suction cup close enough to the small cube for picking-up. For example, the 

suction cup reaches this location called position A. 

 Select SuctionCup on the Operation Panel to turn on the air pump to pick up 

the small cube. 

 Set the PauseTime to 1 second in the Save Point area. 

 Click +Point to save the coordinate corresponding to the position A, as shown 

in Figure 5.28. 

 

Figure 5.28  Save the start position A 

 

 Save the end point B. 

 Select the JUMP motion mode in the Save Point area. 

NOTE 

To change the jogging speed percentage, drag the speed slider. 

 

 Set the lifting height (JumpHeight) and the maximum lifting height (Z Limit) 

by selecting Setting > Playback > JumpParam, as shown in Figure 5.29. 
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Figure 5.29  Jump parameters 

 

 Jogging the Dobot Magician in the Cartesian or Joint coordinate system to move 

the small cube to the end position B as required. 

 Unselect SucktionCup to turn off the air pump to release the small cube. 

 Click +Point to save the coordinate corresponding to the position B, as shown 

in Figure 5.30.  

 

Figure 5.30  Save the end position B 

 

 Set the percentage of both speed and acceleration for playback, for example, 50. 

NOTE 

To change the speed and acceleration of playback, select Setting > Playback > 
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JointParam/CoordinateParm to adjust the speed and acceleration of the Cartesian or 

Joint coordinate system, as shown in Figure 5.31. For details, see Table 5.10. 

 

 

Figure 5.31  Set the speed and acceleration of the playback 

 

Table 5.10  Set the Playback 

Items Description 

JointParam Set the speed and acceleration of the joints 

CoordinateParam Set the speed and acceleration in the Cartesian coordinate system 

JumpParam Set the Jump height and Z limit, which are required in the JUMP motion mode 

Handhold 

Teaching 

Enable or disable the handhold teaching.  

Automatically save a point when releasing the unlock button  or pressing this button 

LostStepParam Set the lost-step checking threshold 

 

 Set Loop to 2. 

 Place the small object back to the position A, and click Start. The Dobot Magician 

performs the sequence of JUMP trajectory as taught from its memory system, moving 

the small cube from positions A through B. 
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Figure 5.32  Move the small cube in the JUMP motion mode 

 

 Working in Offline Mode 

Offline mode allows the Dobot Magician to perform the points in the Save points list previously 

downloaded from the DobotStudio without keeping the USB connection established. 

Prerequisites 

 The Dobot Magician has been powered on. 

 The Dobot Magician has been connected to the DobotStudio. 

 The points have been saved. 

Procedure 

 Click the Easy/Pro slider to enter the Pro mode on the Teaching & Playback page. 

 Click Download. 

The Question dialog box is displayed, asking if you want the Dobot Magician to 

automatically to go back to its homing point before performing the save points in the 

offline mode, as shown in Figure 5.33. 

 

Figure 5.33  Click Download 
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 Click OK to download the Save points list. 

When the process bar at the bottom of the DobotStudio page shows 100% and then 

disappears, it means that the download is complete, as shown in Figure 5.34.  

 

Figure 5.34  The process bar at the bottom of the DobotStudio page 

 

 Disconnect the DobotStudio from the Dobot Magician or the USB cable between the 

robotic arm and your computer. 

 Press the Key button once on the base’s rear panel. 

The Dobot Magician returns to its homing point and performs the downloaded save 

points. To stop the robotic arm’s movement, press the Key button once. 
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 Writing and Drawing 

Figure 5.35 shows the process of writing and drawing. 

 

Figure 5.35  The process of writing and draw 

 

 Installing a Writing Kit 

A writing kit consists of a pen and a pen holder. For detailed steps, see below. 

 Install a pen in the pen holder. 

 Fasten the writing kit to the Dobot Magician’s end with a butterfly nut, as shown in 

Figure 5.36. 

 

Figure 5.36  Install a writing kit 
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NOTE 

To change to a new pen, unfasten the four M3*5 set screws in the pen holder with a 

1.5mm hexagon wrench, as shown in Figure 5.37. 

 

Figure 5.37  Change to a new pen 

 

 Position a sheet of paper on the work surface within the workspace of the Dobot 

Magician. 

 Connecting the DobotStudio 

 Launch the DobotStudio, and select the COM port, and then click Connect. 

If the current firmware of the Dobot Magician is the 3D Printing firmware instead of 

the Dobot firmware, the Select tool dialog box is displayed, asking if you want to 

switch to the Dobot firmware. In this case, perform the following steps to switch to 

this firmware. 

 Select DobotStudio to upgrade the Dobot firmware, as shown in Figure 5.38. 

The Question dialog box is displayed. 

 

Figure 5.38  Select the DobotStudio to upgrade the Dobot firmware 

 

 Click OK, as shown in Figure 5.39. 

The Dobot firmware upgrade window is displayed. 
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Figure 5.39  Confirm the firmware upgrade 

 

 Click Confirm to upgrade the Dobot firmware, as shown in Figure 5.40. When 

the upgrade process bar shows 100%, and a short beep sound is heard, it means 

that the firmware is upgraded successfully, as shown in Figure 5.41. In this case, 

the LED indicator turns from red to green. Then click Quit to exit. 

 

Figure 5.40  Click Confirm 

 

 

Figure 5.41  The firmware upgrade is successful 
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WARNING 

During the firmware upgrade, do not stop it. Otherwise, errors occur. 

 

 Click Connect on the DobotStudio page to connect the DobotStudio to the Dobot 

Magician. 

 Click Write & Draw, as shown in Figure 5.42. 

 

Figure 5.42  Click Write & Draw 

 

 Choose Pen as the end-effector on the Write & Draw page, as shown in Figure 5.43. 

 

Figure 5.43  Choose Pen as the end-effector 

 

 Importing Image Files and Setting Writing Parameters 

When performing a write & draw task, a built-in or custom image file is required. Only a PLT 

or SVG image can be used. The built-in file is located in the directory Installation 

Directory\DobotStudio\config\prefab\system\source. 
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Prerequisites 

A PLT or SVG image file has been created. 

Procedure 

 Click Write & Draw on the DobotStudio page, as shown in Figure 5.44. 

 

Figure 5.44  Click Write & Draw 

 

 Import an image file using one of the following methods. 

NOTICE 

The imported image should be placed within the annular area on the Write & Draw page, 

as shown in Figure 5.45. If not, the robotic arm reaches its limited position and cannot 

draw or write. In this case, the image is highlighted with a red border, as shown in Figure 

5.46. 

 

Figure 5.45  The PLT or SVG image is located within the annular area 
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Figure 5.46  The PLT or SVG image is located outside the annular area 

 

 Click Open on the Write & Draw page to import a built-in PLT or SVG image file from 

the DobotStudio installation directory 

InstallatonDirectory\DobotStudio\config\prefab\system\source, as shown in Figure 

5.47. You can also import your custom PLT or SVG image file. 

 

Figure 5.47  Open a PLT or SVG system image file 

 

 Click a shape in the Input Shapes area, as shown in Figure 5.48. 
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Figure 5.48  Insert a system image file 

 

 Click Input Texts on the Write & Draw page to input texts, and set its style, and then 

click OK to display the text on the annular area, as shown in Figure 5.49. 

 

Figure 5.49  Input text 

 

 Click Open to import an image file such as BMP, JEPG, or PNG to convert this image to 

its corresponding SVG file that the DobotStudio supports, as shown in Figure 5.50. Once 

this image is imported, the SVG Converter dialog box is displayed, as shown in Figure 

5.51. In this dialog box, drag the slider to set the black and white threshold, and click 

Convert Bitmap To SVG to perform the conversion, and then click Plot to Main Scene 
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to display the converted SVG file on the annular area of the Write & Draw page. 

 

Figure 5.50  Import an image 

 

 

Figure 5.51  Convert an image to SVG 

 

 Set the writing parameters. 

 Click Setting on the Write & Draw page, as shown in Figure 5.52. 
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Figure 5.52  Click Setting 

 

 Click Write & Draw to set the Dobot Magician’s Velocity (mm/s), junction 

velocity (JunctionVel: mm/s), PlanAcc (mm/s2), acceleration (Acc: mm/s2), 

PenUpOffset (mm), PenDown (mm), as shown in Figure 5.53. 

 

NOTE 

We recommend to set the Velocity in the range of 0mm/s to 500mm/s and to adjust the 

acceleration between 0mm/s2 and 500mm/s2. 
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Figure 5.53  Setting the parameters of the Write & Draw function 

 

 Adjust the Position of the Pen Nib 

Procedure 

 Raise and lower the position of the pen nib. 

Press and hold the unlock button  on the Forearm to move the Dobot Magician 

to raise and lower the pen nib until it slightly squeezes the paper. You can also jog 

the robotic arm in the Cartesian or Joint coordinate system to slowly pull the Z axis 

down to a suitable vertical position for writing, as shown in Figure 5.54. 

 

Figure 5.54  Adjust the position of the pen nib  
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NOTE 

The point marked by a red box, as shown in Figure 5.55, corresponds to the position of 

the writing kit of the Dobot Magician. This point changes its position only within the 

annular area when the robotic arm moves. 

 

Figure 5.55  The point corresponding to the laser kit of the robotic arm 

 

 Click AutoZ on the Write & Draw page to obtain and save the current value of the 

Z axis.  

 

Figure 5.56  Lock the height of writing 
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NOTE 

The value of the Z axis is the PenDown parameter. This parameter can be set by selecting 

Setting > Write Draw > PenDown on the Write & Draw page, as shown in Figure 5.57. 

If the effect of writing is not satisfactory, slightly raise and lower the height of the writing 

kit or directly change the value of PenDown. 

 

 

Figure 5.57  The PenDown parameter 

 

 Click SyncPos. 

The Dobot Magician automatically moves above the position (PenDown) of the start 

point of the text. 

 Click Start to start writing on the paper. 

When writing, click Pause to pause the writing and Stop to halt the writing. 

 Performing Laser Engraving Tasks 

Figure 5.58 shows the process of laser engraving. 
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Figure 5.58  The process of laser engraving 

 

NOTICE 

The LaserEngraving is different is from the grayscale engraving. The former uses the 

same firmware and DobotStudio function module as those of the Write & Draw 

function, and it can only engrave a vector graphics by drawing lines while the latter can 

engrave a grayscale image. For more information about the grayscale engraving, see 5.6 

Engraving a Grayscale Image. 

 

 Installing a Laser Kit 

Procedure 

A laser kit includes a laser. For detailed steps, see below. 

 Fasten the laser kit to the Dobot Magician's end with a butterfly nut, as shown in 

Figure 5.59. 
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Figure 5.59  Fasten the laser with a butterfly nut 

 

 Connect the laser’s power cable to the SW4 connector on the Forearm and the TTL 

control cable to the GP5 connector, as shown in Figure 5.60. 

 

Figure 5.60  Connect the laser to the SW4 and GP5 connectors 
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 Connecting the DobotStudio 

 Launch the DobotStudio, and select the COM port, and then click Connect. 

If the current firmware of the Dobot Magician is the 3D Printing firmware instead of 

the Dobot firmware, the Select tool dialog box is displayed, asking if you want to 

switch to the Dobot firmware. In this case, perform the following steps to switch to 

this firmware. 

 Select DobotStudio to upgrade the Dobot firmware, as shown in Figure 5.61. 

The Question dialog box is displayed. 

 

Figure 5.61  Select the DobotStudio to upgrade the Dobot firmware 

 

 Click OK, as shown in Figure 5.62. 

The Dobot firmware upgrade window is displayed. 

 

Figure 5.62  Confirm the firmware upgrade 

 

 Click Confirm to upgrade the Dobot firmware, as shown in Figure 5.63. When 

the upgrade process bar shows 100% and a short beep sound is heard, it means 

that the firmware is upgraded successfully, as shown in Figure 5.64. In this case, 

the LED indicator turns from red to green. Then click Quit to exit. 
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Figure 5.63  Click Confirm 

 

 

Figure 5.64  The firmware upgrade is successful 

 

WARNING 

During the firmware upgrade, do not stop it. Otherwise, errors occur. 

 

 Click Connect on the DobotStudio page to connect the DobotStudio to the Dobot 

Magician. 

 Click Write & Draw module function, as shown in Figure 5.65. 
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Figure 5.65  Click Write & Draw 

 

 Choose Laser as the end-effector, as shown in Figure 5.66. 

 

Figure 5.66  Choose Laser as the end-effector 

 

 Importing Image Files and Setting Engraving Parameters 

When performing a laser-engraving task, a built-in or a custom image file is required. Only a 

PLT or SVG image can be used. The built-in image file is located in the directory Installation 

Directory\DobotStudio\config\prefab\system\source. 

Prerequisites 

A PLT or SVG image file has been created. 

Procedure 

 Click Write & Draw on the DobotStudio page, as shown in Figure 5.67. 
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Figure 5.67  Click Write & Draw 

 

 Import an image file using one of the following methods. 

NOTICE 

The imported image should be placed within the annular area on the Write & Draw page, 

as shown in Figure 5.68. If not, the robotic arm reaches its limited position and thus 

cannot engrave on an object. In this case, the image is highlighted with a red border, as 

shown in Figure 5.69. 

 

 

Figure 5.68  The PLT or SVG image is located within the annular area 
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Figure 5.69  The PLT or SVG image is located outside the annular area 

 

 Click Open on the Write & Draw page to import a built-in PLT or SVG image file from 

the DobotStudio installation directory 

InstallatonDirectory\DobotStudio\config\prefab\system\source, as shown in Figure 

5.70. You can also import your custom PLT or SVG image file. 

 

Figure 5.70  Open a PLT or SVG file 

 

 Click a shape in the Input Shapes area to directly import a system image file, as shown 

in Figure 5.71. 
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Figure 5.71  Insert a system image file 

 

 Click Input Texts on the Write & Draw page to input texts, and set its style, and then 

click OK to display the text on the annular area, as shown in Figure 5.72. 

 

Figure 5.72  Input text 

 

 Click Open to import an image file such as BMP, JEPG, or PNG to convert this image to 

its corresponding SVG file that the DobotStudio supports, as shown in Figure 5.73. Once 

this image is imported, the SVG Converter dialog box is displayed, as shown in Figure 

5.74. In this dialog box, drag the slider to set the black and white threshold, and click 

Convert Bitmap To SVG to perform the conversion, and then click Plot to Main Scene 
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to display the converted SVG file on the annular area of the Write & Draw page. 

 

Figure 5.73  Import an image file 

 

 

Figure 5.74  Convert Bitmap to SVG 

 

 Set the laser-engraving’s parameters. 

 Click Setting on the Write & Draw page, as shown in Figure 5.75. 
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Figure 5.75  Click Setting 

 

 Click Write & Draw to set the Dobot Magician’s Velocity (mm/s), junction 

velocity (JunctionVel: mm/s), PlanAcc (mm/s2), acceleration (Acc: mm/s2), 

PenUpOffset (mm), PenDown (mm), as shown in Figure 5.76. 

 

NOTE 

We recommend to set the Velocity in the range of 0mm/s to 500mm/s and to adjust the 

acceleration between 0mm/s2 and 500mm/s2. 
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Figure 5.76  Setting the parameters of the Write & Draw function 

 

 Adjust the Laser Focus and Start to Grave 

Procedure 

 Choose Laser as the end-effector on the Write & Draw page, as shown in Figure 

5.77. 

 

Figure 5.77  Choose Laser as the end-effector 

 

 Click  to display the Operation Panel, and then select Laser to turn on the laser, 

as shown in Figure 5.78. In this case, the laser gives out a laser beam. 
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Figure 5.78  Turn on the laser 

 

DANGER 

 When using a laser, wear lasing protective eyeglass. 

 Never aim the laser at a person’s eye and clothes or stare at the laser from within 

the beam. 

 In the central laser focus, a high temperature heat is created and can burn materials 

such as papers and wooden boards. 

 Never aim the laser at a person and their clothes. 

 Do not allow the children to play with the Dobot Magician. Monitor the robotic arm 

while it is running and power off it once the movement is complete. 

 

 Press and hold the unlock button  on the Forearm to move the robotic arm to 

raise and lower the height of the laser kit until the laser is the brightest with a smallest 

possible spot size. When the laser power level is high enough, the laser beam can 

burn and cut the paper. After getting a pretty good focus, unselect Laser on the 

Operation Panel page to turn off the laser, as shown in Figure 5.79.  
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Figure 5.79  Unselect the Laser 

 

NOTICE 

 If you cannot set the laser to be at its minimum focus, it’s probably because the focal 

length is long. To shorten the focal length, slightly turn the sliver lens screw (as 

shown in Figure 5.80) on the bottom of the laser kit. 

 

Figure 5.80  Adjust the laser focus 

 

 The point marked by a red box, as shown in Figure 5.81, corresponds to the position 

of the end-effector of the Dobot Magician. This point changes its position only 

within the annular area when the robotic arm moves. 
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Figure 5.81  The point corresponding to the end-effector of the robotic arm 

 

 Click AutoZ on the Write & Draw page to obtain and save the current value of Z 

axis.  

Once this step is complete, the next time you start to engrave, directly import a PLT 

or SVG image file without adjusting the position of the laser kit, and click SyncPos, 

and then click Start to start engraving on the paper, as shown in Figure 5.82. 

 

Figure 5.82  Lock the height of engraving 

 

NOTE 

The value of the Z axis is the PenDown parameter. This parameter can be set by selecting 

Setting > Write Draw > PenDown on the Write & Draw page, as shown in Figure 5.83. 

If the effect of engraving is not satisfactory, slightly raise and lower the height of the laser 

kit or directly change the value of PenDown. 
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Figure 5.83  Set the PenDown parameters 

 

 Click SyncPos. 

The Dobot Magician automatically moves above the position (PenUpOffset) of the 

start point of the laser-engraving. 

 Click Start to start engraving on the paper. 

When engraving, click Pause to pause the engraving and Stop to halt the engraving. 

Figure 5.84 shows the effect of the laser-engraving. 
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Figure 5.84  The effect of the laser-engraving 

 

 Engraving a Grayscale Image 

Figure 5.85 shows the process of engraving a grayscale image. 

 

Figure 5.85  The process of engraving a grayscale image 

 

 Installing a Grayscale-engraving Kit 
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Both grayscale-engraving and laser-engraving use the laser kit as the end-effector. For the 

installation method, see 5.5.1 Installing a Laser Kit. 

 Connecting the DobotStudio 

 Launch the DobotStudio, and select the COM port, and then click Connect. 

If the current firmware of the Dobot Magician is the 3D Printing firmware instead of 

the Dobot firmware, the Select tool dialog box is displayed, asking if you want to 

switch to the Dobot firmware. In this case, perform the following steps to switch to 

this firmware. 

 Select DobotStudio to upgrade the Dobot firmware, as shown in Figure 5.86. 

The Question dialog box is displayed. 

 

Figure 5.86  Select the DobotStudio to upgrade the Dobot firmware 

 

 Click OK, as shown in Figure 5.87. 

The Dobot firmware upgrade window is displayed. 

 

Figure 5.87  Confirm the firmware upgrade 

 

 Click Confirm to upgrade the Dobot firmware, as shown in Figure 5.88. When 

the upgrade process bar shows 100%, and a short beep sound is heard, it means 

that the firmware is upgraded successfully, as shown in Figure 5.89. In this case, 

the LED indicator turns from red to green. Then click Quit to exit. 
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Figure 5.88  Click Confirm 

 

 

Figure 5.89  The firmware upgrade is successful 

 

WARNING 

During the firmware upgrade, do not stop it. Otherwise, errors occur. 

 

 Click LaserEngraving, as shown in Figure 5.90. 
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Figure 5.90  Click LaserEngraving 

 

 Importing Image Files and Setting Engraving Parameters 

Prerequisites 

An image file has been created. 

Procedure 

NOTICE 

The imported image should be placed within the annular area on the LaserEngraving 

page, as shown in Figure 5.91. If not, the robotic arm reaches its limited position and thus 

cannot engrave on an object. In this case, the image is highlighted with a red border, as 

shown in Figure 5.92. 
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Figure 5.91  The image file is located within the annular area 

 

 

Figure 5.92  The image file is located outside the annular area 

 

 Choose Laser as the end-effector on the LaserEngraving page, as shown in Figure 

5.93. 
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Figure 5.93  Choose Laser as the end-effector 

 

 Click Open to import an image file such as BMP, JPEG, or PNG, as shown in Figure 

5.94. 

 

Figure 5.94  Import an image file 

 

 Set the Grayscale range, Laser power range, and Border, as shown in Figure 5.95. 

For details, see Table 5.11. 

 

Figure 5.95  Set the grayscale range, laser power range, and border 
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Table 5.11  Laser engraving parameters 

Items Description 

Grayscale range Set the grayscale range 

Range: 0 - 255 

Default value: 20 - 240 

Laser power range Set the laser power range 

Range: 2 - 100 

Default value: 20 - 90 

Border Set the border width. 

Unit: pixel 

Range: 0 - 50 

Default value: 4 

 

 Set the laser-engraving parameters. 

 Click Setting on the LaserEngraving page. 

 Set the JunctionVel (junction velocity), PlanAcc (linear acceleration), and Acc 

(acceleration), for example, set all to 5, as shown in Figure 5.96. 

 

Figure 5.96  Set the parameters of laser engraving 
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 Adjust the Laser Focus and Start to Engrave 

 Click  to display the Operation Panel, and then select Laser to turn on the laser, 

as shown in Figure 5.97. In this case, the laser gives out a laser beam. 

Danger 

 When using a laser, wear lasing protective eyeglass. 

 Never aim the laser at a person’s eye and clothes or stare at the laser from within 

the beam. 

 In the central laser focus, a high-temperature heat is created and can burn materials 

such as papers and wooden boards. 

 Never aim the laser at a person and their clothes. 

 Do not allow the children to play with the Dobot Magician. Monitor the robotic arm 

while it is running and power off it once the movement is complete. 

 

 

Figure 5.97  Select the Laser 

 

 Adjust the laser focus. 

Press and hold the unlock button  on the Forearm to move the robotic arm to 

raise and lower the height of the laser kit until the laser is the brightest with a smallest 

possible spot size. When the laser power level is high enough, the laser beam can 

burn and cut the paper. After getting a pretty good focus, unselect Laser on the 

Operation Panel page to turn off the laser, as shown in Figure 5.98. 
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Figure 5.98  Unselect the Laser 

 

NOTICE 

 If you cannot set the laser to be at its minimum focus, it’s probably because the focal 

length is long. To shorten the focal length, slightly turn the sliver lens screw (as 

shown in Figure 5.99) on the bottom of the laser kit. 

 

 

Figure 5.99  Adjust the focus 

 

 The point marked by a red box, as shown in Figure 5.100, corresponds to the 

position of the laser kit of the Dobot Magician. This point changes its position only 

within the annular area when the robotic arm moves. 



                     Dobot Magician User Guide 5 Operation 

Issue V1.0 (2018-06-12) User Guide Copyright © Yuejiang Technology Co., Ltd. 

 90  

 

Figure 5.100  The point corresponding to the laser kit of the robotic arm 

 

 Click AutoZ on the LaserEngraving page to obtain and save the current value of 

the Z axis. 

 

Figure 5.101  Lock the height of engraving 

 

NOTE 

The value of Z axis is the PenDown parameter. This parameter can be set by selecting 

Setting > LaserEngraving > PenDown, as shown in Figure 5.102. If the effect of 

engraving is not satisfactory, slightly raise and lower the height of the laser kit or directly 

change the value of PenDown. 
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Figure 5.102  Set the PenDown parameters 

 

 Click SyncPos. 

The Dobot Magician automatically moves above the position of the start point of the 

laser-engraving. 

 Click Start to start engraving on the paper. 

When engraving, click Pause to pause the engraving and Stop to halt the engraving. 

Figure 5.103  shows the effect of the laser-engraving. 
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Figure 5.103  The effect of laser-engraving 

 

 Controlling with your Hand Gesture 

You can use the LeapMotion function module of the DobotStudio to perform tasks, for 

example, grab or suck an object with your hand gesture. 

 Installing a Leap Motion Controller 

Prerequisites 

 The Leap Motion controller (a hand gesture controller) has been obtained. 

 The Leap Motion driver software has been obtained. Download the Windows version, as 

shown in Figure 5.104, from the https://www.leapmotion.com/setup/desktop/windows. 

 

 

Figure 5.104  Download the Leap Motion driver software for Windows  

 

https://www.leapmotion.com/setup/desktop/windows
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Procedure 

 Connect a Leap Motion controller to your computer with a USB cable, and put it on 

the work surface with its face up, as shown in Figure 5.105. 

 

Figure 5.105  Connect the Leap Motion controller to your computer 

 

 Install the Leap Motion driver software by following the on-screen instructions, as 

shown in Figure 5.106. 

 

Figure 5.106  The Leap Motion Installation Interface 

 

 Leap Motion Demo 

You can move or sort an object with the LeapMotion function. This topic introduces how to 
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move a small cube with a hand gesture. 

Prerequisites 

 The Dobot Magician is powered on and connected to your computer. 

 The suction cup kit has been installed. For details, see 5.2.1 Installing a Suction Cup Kit. 

Procedure 

 Launch the DobotStudio, and click Connect to connect to the Dobot Magician. 

 Click LeapMotion, as shown in Figure 5.107. 

 

Figure 5.107  Click LeapMotion 

 

 Click Setting on the DobtStudio page, as shown in Figure 5.108. 

 

Figure 5.108  Click Setting 
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 Click Leap Motion, as shown in Figure 5.109. Set the parameters, as shown in Table 

5.12, and click OK. 

 

Figure 5.109  Set the parameters of the Leap Motion function 

 

Table 5.12  Set the parameters of the Leap Motion function 

Items Description 

Speed The velocity percentage of the Dobot Magician: 

Unit: % 

Value range: 1 - 100 

Default value: 50 

Scale The scale of the Dobot Magician: 

Unit: % 

Value range: 1 - 100 

Default value: 100 

High performance/Low 

performance 

Choose a performance mode suitable for your computer. Select the Low 

performance (default) for the low configuration computer to prevent 

video delay 

 

 Choose SuctionCup as the end-effector on the DobotStudio page, and click Start 

to control the Dobot Magician with your hand gesture, as shown in Figure 5.110. To 

maintain the Dobot Magician in a stable state, move your hand into the workspace 

of the Leap Motion controller while keeping your palm upward. And turn your palm 

down, and then move your hand above this area to control the Dobot Magician. 

 



                     Dobot Magician User Guide 5 Operation 

Issue V1.0 (2018-06-12) User Guide Copyright © Yuejiang Technology Co., Ltd. 

 96  

 

Figure 5.110  Click Start 

 

NOTE 

Move your hand in the workspace of the Leap Motion controller to control the Dobot 

Magician to perform a particular task, as shown in Table 5.13. 

 

Table 5.13  The robotic arm’s movement created with your hand gesture 

Hand gesture Robotic arm’s movement 

Move your palm up, down, front, 

back, right, or left 

The robotic arm moves accordingly 

Clench your fist Control the air pump to suck air 

Unclench your fist Turn off the air pump 

 

 Put a small cube on the work surface in the workspace of the Dobot Magician, such 

as point A, and use the hand gesture to move robotic arm above the cube until it’s 

close to the cube. 

 Clench your fist to control the air pump to suck the small cube, and move your fist 

to make Dobot Magician take the cube to another position while clenching your fist, 

such as position B, and then unclench your fist to turn off the air pump to drop the 

cube. 

 Turn your palm upward and click Stop to stop the hand control. 

 Controlling with your Mouse 

You can use the Mouse function module of the DobotStudio to perform tasks, for example, 

grab or suck an object with your mouse. This topic introduces how to move a small cube with a 

mouse. 
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Prerequisites 

 The Dobot Magician is powered on and connected to your computer. 

 The suction cup kit has been installed. For details, see 5.2.1 Installing a Suction Cup Kit. 

Procedure 

 

 

Figure 5.111  Click Mouse  

 

 

 

Figure 5.112  Choose SuctionCup as the end-effector 
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Figure 5.113  Click Setting 

 

Click Mouse, as shown in Figure 5.114. Set the parameters, as shown in  

Table 5.14, and click OK. 

 

Figure 5.114  Set the parameters of mouse control 
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Table 5.14  Set the parameters of mouse control 

Parameters Description 

Speed The velocity percentage of the Dobot Magician: 

Unit: % 

Value range: 1 - 100 

Default value: 50 

Scale The scale of the Dobot Magician: 

Unit: % 

Value range: 1 - 100 

Default value: 100 

High 

performance/Low 

performance 

Choose a performance mode suitable for your computer. Select Low 

performance (default) for the low configuration computer to prevent video delay 

 

 

 

NOTICE 

Do not move the mouse outside the red annular area. If not, the robotic arm reaches its 

limited position. In this case, drag the mouse to into the annular area. 

 

 

Figure 5.115  Move the robotic arm in the red annular area 
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NOTE 

For details on how to use the mouse to control the robotic arm on the Mouse page, see 

Table 5.15. 

 

Table 5.15  The robotic arm’s movement created with your mouse 

Mouse action Robotic arm’s movement 

Move your mouse front, 

back, right, or left 

The robotic arm moves accordingly 

Scroll the mouse wheel 

up or down 

The robotic arm moves accordingly 

Press and hold the left 

mouse button 

Suction cup: the air pump sucks air in 

Gripper: increase holding force 

Release the left mouse 

button 

Suction cup: the air pump is powered off 

Gripper: open 

Right-click the mouse 

button 

Gripper: close 

 

 

 

 Operating 3D Printing 

After installing 3D printing kit, you can import 3D module into the 3D printing software for 

3D printing. Figure 5.116 shows the 3D printing process. 
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Figure 5.116  3D printing process 

 

During 3D printing, the 3D printing control software is required. You can use Repetier Host 

or Cura software for 3D printing. 

 Reptier-Host: Reptier-Host can slice with the third party slicing (such as CuraEngine, 

Slic3r, etc), check and modify G-Code, control 3D printing manually. More parameter 

settings make Reptier-Host very flexible. 

 Cure: The slicing of Cura is fast and stable. It has strong inclusiveness to 3D model 

structure and less parameter settings. 

NOTICE 

This section uses Windows as an example to describe how to perform 3D printing with 

Repetier Host and Cura. For Mac OS, only Cura is supported. 

 

 Installing 3D Printing Kit 

3D printing kit contains extruder, hot end, motor cable, filament, and filament holder as shown 

in Figure 5.117. 
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Figure 5.117  3D printing kit 

 

Procedure 

 Press down the lever on the extruder, and push down the filament to the bottom of 

the hole via the pulley, as shown in Figure 5.118. 
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Figure 5.118  Push down the filament 

 Connect the end of the PTFE tube to the hot end and push it down to the bottom of 

the hot end, and connect the other end to the extruder, as shown in  

 

Figure 5.119  Connect extruder and hot end 

 

 Insert the filament into the PTFE tube and push it down to the bottom of the hot end. 
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NOTICE 

Please make sure that the PTFE tube has been pushed down to the bottom of the hot end. 

Otherwise, it will cause abnormal discharge. 

 

 Fix the hot end on the Dobot Magician with butterfly nut, as shown in Figure 5.120. 

 

Figure 5.120  Fix hot end 

 

 Insert the heating cable to the interface 4 on the Forearm, the fan cable to the interface 

5 and the thermistor cable to the interface 6, as shown in Figure 5.121. 
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Figure 5.121  Connect hot end to the Forearm 

 

 Connect the extruder to the Stepper1 interface on the back of the base with motor 

cable, as shown in Figure 5.122. 

  

Figure 5.122  Connect with extruder 
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 Place the filament and the extruder to the filament holder, as shown in Figure 5.123. 

 

Figure 5.123  Place filament and extruder to the Filament holder 

 

 Operating Repetier Host 

Repeiter Host has been built into DobotStudio. After burning 3D printing firmware, the 

Repetier Host page will be displayed automatically. 

Prerequisites 

 The 3D printing model has been prepared. 

 The printing platform has been prepared and please place it in the workspace of the Dobot 

Magician. 

 Dobot Magician has been powered on. 

 Dobot Magician has been connected to DobotStudio successfully (Only USB connection 

is supported). 

 The 3D printing kit has been installed. 

5.9.2.1 Burning Firmware 

Procedure 

 Click 3DPrinter on the DobotStudio page. 

The 3D Printing FM page is displayed, as shown in Figure 5.124. 
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Figure 5.124  Burn firmware 

 

 Click Confirm to start burning 3D printing firmware. 

After burning 3D printing firmware, the Repetier Host page is displayed 

automatically, as shown in Figure 5.125. 

If the LED indicator on the base turns red, it indicates that the connection of the 3D 

printing kit is abnormal. 

WARNING 

Please DO NOT operate or turn off Dobot Magician when burning firmware, to avoid 

machine damage. 

 

 

Figure 5.125  Repetier Host page 
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NOTICE 

If the current firmware is set for 3D printing when operating 3D printing, you can click 

Connect directly on the DobotStudio page. And then Click OK on the Select tool page 

to switch to Repetier Host, as shown in Figure 5.126. 

 

  

Figure 5.126  Switch into 3D printing automatically 

 

5.9.2.2 Performing 3D Printing 

Procedure 

 Set printing parameters. 

Printing parameters only need to be set for the first time.  

 Click Printer Settings on the top right corner of the Pepetier Host page. 

The Printer Settings page is displayed. 

 Set the corresponding parameters on the Connection tab as shown in the red 

box of Figure 5.127. The other parameters are set by default. 
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Figure 5.127  Connection setting 

 

 Click Apply. 

 Unselect the corresponding options on the Printer tab as shown in the red box 

of Figure 5.128 and the other parameters are set by default. Then, click Apply. 
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Figure 5.128  Unselect options 

 

 Set the corresponding parameters on the Extruder tab as shown in the red box 

of Figure 5.129, the other parameters are set by default. Then, Click Apply. 
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Figure 5.129  Extruder settings 

 

 Set the corresponding parameters on the Printer Shape tab as shown in the red 

box of Figure 5.130, the other parameters are set by default. Then, Click Apply. 
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Figure 5.130  Printer shape settings 

 

 Click OK 

 Click Connect on the Repetier Host page to connect Dobot Magician. 

After the connection is successful, the current heating temperature will be shown on 

the below of the Repetier Host page, as shown in Figure 5.131. 

 

Figure 5.131  Connect to Dobot Magician 
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 Text extruder. 

Before printing, you need to test the extruder to check whether the melted filament 

flows from the nozzle of the extruder. 

The temperature of the extruder should be above 170℃. Dobot Magician will not 

start 3D printing until the filament is in the melting state. So you need to heat the 

extruder first. 

 Set the heating temperature to 200℃ on the Manual Control tab of the 

Repetier Host page and click , as shown in Figure 5.132. 

DANGER 

The heating rod will produce high temperature up to 250℃, please be careful. Do not let 

children play with it alone. The process needs to be monitored when it is running. After 

the process is completed, please turn off the equipment promptly. 

 

 

Figure 5.132  Heat the extruder 

 

 Click the extruder feeder when the heating temperature is up to 200℃ and feed 

up to10mm-30mm, as shown in Figure 5.133. 
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Figure 5.133  Extrude filament 

 

If the melted filament flows from the nozzle of the extruder, the extruder is 

working properly. 

NOTICE 

If the filament extrusion is in the opposite direction. Please remove the filament, and turn 

the extruder around, then re-push down the filament. 

 

 Adjust the printing space and get the printing coordinates. 

NOTE 

During printing, if the distance from Dobot Magician to the printing platform is too large 

or too small to paste the first layer, it can lead to the nozzle blockage. For increasing the 

stickiness of the first layer, placing a masking paper on the platform is recommended. 

 

 Press the Unlock key on the Forearm and drag Dobot Magician to make the 

printing head contact the surface of the masking paper (The distance between 

the printing head and the surface of the masking paper is the thickness of a sheet 

of A4 paper), then release the Unlock key. 

 Input command M415 on the G-Code command window and press Enter to 

get the current coordinates, as shown in Figure 5.134. 

Also, you can press the Key button on the bace of the base to get the current 
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coordinates. 

 

Figure 5.134  Input M415 

 

NOTE 

If you cannot find the G-Code command window, please click EASY to close Easy 

Mode, as shown in Figure 5.135. 

 

 

Figure 5.135  Easy mode 

 

 Click Load to import the prepared 3D printing model, as shown in Figure 5.136. 



                     Dobot Magician User Guide 5 Operation 

Issue V1.0 (2018-06-12) User Guide Copyright © Yuejiang Technology Co., Ltd. 

 116  

 

Figure 5.136  Import 3D printing Model 

 

After importing the model, you can center, zoom, or rotate the model on the 

Object Placement page, as shown in Figure 5.137. 

 

Figure 5.137  Model operation 

 

 Set slicing parameters and slice up. 

You need to set the slicing parameters before first printing. 
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 Select Slic3r from Slicer on the Slicer tab of the Repetier Host page, and click 

Configuration, as shown in Figure 5.138. 

 

Figure 5.138  Select slicer 

 

The Slic3r page is displayed, as shown in Figure 5.139. 

 

Figure 5.139  Slic3r page 
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 Set the slicing parameters on the Slic3r page. 

The 3D printing effect depends on the slice parameters. This topic provides a 

configuration sample, you can select File > Load Config on the Slic3r page to 

import it directly for printing. 

The path of the configuration sample is Installation 

directory\DobotStudio\attachment, as shown in Figure 5.140. 

 

Figure 5.140  Configuration sample 

 

Dobot-2.0-Vase.ini is used for printing a thin-walled vase, while Dobot-2.0-ini 

is used for the filling, the filling rate is 20%. 

 Save the Printing Settings, Filament Settings and Printer Settings tabs 

respectively after importing configuration sample, as shown in Figure 5.141. 

 

Figure 5.141  Save configuration file 
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 Click Slici with Slic3r on the Slicer tab of the Repetier Host page, as shown 

in Figure 5.142. 

 

Figure 5.142  Start to slice 

 

 Click  on the top left corner of the Repetier Host page to print. 

 

Figure 5.143  Start printing 

 

Here we choose vase mode to print, and the product after printing as shown in Figure 5.144. 
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Figure 5.144  The product of printing 

 

 Operating Cura 

If you need to use Cura software for 3D printing, please launch the Cura software after burning 

firmware. 

Prerequisites 

 Slice software Cura has been installed.  

The download path is https://ultimaker.com/en/products/ultimaker-cura-software/list. 

Please download the recommended version V14.07. The way how to install and use is not 

descripted in this topic. 

 The 3D printing model has been prepared. 

 The printing platform has been prepared and please place it in the workspace of Dobot 

Magician. 

 Dobot Magician has been powered on. 

 Dobot Magician has been connected to DobotStudio successfully (Only USB connection 

is supported). 

 The 3D printing kit has been installed. 

5.9.3.1 Burning Firmware 

Procedure 

 Click 3DPrinter on the DobotStudio page. 

The 3D Printing FM page is displayed, as shown in Figure 5.145. 

https://ultimaker.com/en/products/ultimaker-cura-software/list
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Figure 5.145  Burn firmware 

 

 Click Confirm to start burning 3D printing firmware. 

After burning 3D printing firmware, if the LED indicator on the base turns red, it 

indicates that the connection of the 3D printing kit is abnormal. 

WARNING 

Please DO NOT operate or turn off Dobot Magician when burning firmware, to avoid 

machine damage. 

 

5.9.3.2 Performing 3D Printing 

Procedure 

 Launch Cura software. 

 Set slicing parameters. 

 Select Machine > settings on the Cura page. 

The Machine settings page is displayed. 

 Set the corresponding parameters on the Machine settings and click OK, as 

shown in Figure 5.146. Table 5.16 lists the values of the parameters that need 

to be set. The other parameters are set by default. 
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Figure 5.146  Parameters setting 

 

Table 5.16  3D printing parameters description 

Parameter Description 

Maximum width The maximum width 

please set to 80mm 

Maximum depth The maximum with  

please set to 80mm 

Maximum height The maximum height 

Please set to 150mm 

Machine center 0,0 Machine center, please select it 

GCode Flavor The style of GCode 

Please select RepRap Marlin/Sprinter 

Build area shape Build the area shape 

Please select Circular 

Serial port Serial port 

Please select the corresponding serial port 

Baudrate Baud rate 

Please set to 115200 

 

 Set slice parameters, and select File > Open Profile to import these parameters, 

as shown in Figure 5.147. 
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Figure 5.147  Import slice parameters 

 

The 3D printing effect depends on the slice parameters. This topic provides a 

configuration sample, you can import it directly for printing. 

The path of the configuration sample is Installation directory\DobotStudio 

\attachment\, as shown in Figure 5.148. 

 

Figure 5.148  Configuration sample 

 

Dobot-2.0-Vase-Cura.ini is used for printing a thin-walled vase, while Dobot-

2.0-Cura.ini is used for the filling, the filling rate is 20%. 

 Click , the Open 3D model page is displayed, and select the 3D 
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printing model prepared. 

The format of 3D model is STL. You can design 3D model and transform it into 

STL format. 

After importing the model, click the model itself, you can center, zoom or rotate, 

and so on, as shown in Figure 5.149. 

 

Figure 5.149  Zoom and rotate 

 

 Click  to connect with Dobot Magician. 

The printing window is displayed and the current printing temperature is shown 

on the top corner of the window, as shown in Figure 5.150. 

 

Figure 5.150  Printing window 

 

 Set Temperature to 200 and press down Enter to heat the extruder. 

The temperature of the extruder should be above 170℃. Dobot Maigicain will 

not start 3D printing until the filament is in the melting state. So you need to 
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heat the extruder first. 

DANGER 

The heating rod will produce high temperature up to 250℃, please be careful. Do not let 

children play with it alone. The process needs to be monitored when it is running. After 

the process is completed, please turn off the equipment promptly. 

 

 Test the extruder. 

Before printing, you need to test the extruder to check whether the melted filament 

flows from the nozzle of the extruder.  

Click the feedstock extruder or click the given stepper, such as 10, 1, 0.1 (10 is 

recommended) on the Operational page and feed up to 10mm-30mm, as shown in 

Figure 5.151. 

 

Figure 5.151  Click feedstock extruder 

 

If the melted filament flows from the nozzle of the extruder, the extruder is working 

properly. 

NOTICE 

If the filament extrusion is in the opposite direction, please remove the filament, and turn 

the extruder around, then re-push down the filament. 

 

 Adjust the printing space and get printing coordinates. 

NOTE 

During printing, if the distance from Dobot Magician to the printing platform is too large 

or too small to paste the first layer, it can lead to the nozzle blockage. For increasing the 

stickiness of the first layer, placing a masking paper on the platform is recommende. 
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 Press the Unlock key on the Forearm and drag Dobot Magician to make the 

printing head contact the surface of the masking paper(The distance between 

the printing head and the surface of the masking paper is the thickness of a sheet 

of A4 paper), then release the Unlock key. 

 Input command M415 on the lower right of the Operational page to get the 

current coordinates, as shown in Figure 5.152. 

Also, you can press the Key button on the bace of the base to get the current 

coordinates. 

 

Figure 5.152  Input command M415 

 

 Click Print, Dobot Magician moves to the printing origin (System setting) and starts 

printing. 

 

 Calibration 

 Base Calibration 

The base Encoder has been calibrated before being shipped out. Generally, the J1-coordinate 

is 0° after homing, where the homing point is the system default. Namely, the Forearm is located at 

the middle in front of the base. 

If the J1-coordinate is not 0° (error range: 1°-3°) after homing, you need to re-calibrate the 

base Encoder. 

Prerequisites 

 The writing kit has been installed. For details, please see 5.4.1 Installing a Writing Kit. 

 Dobot Magician has been powered on. 

 Dobot Magician has been connected to DobotStudio successfully. 

 The sensor calibration board has been prepared. 

Procedure 

 Place the Dobot Magician at the right position on the sensor calibration board, as 

shown in Figure 5.153. 
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Figure 5.153  Location of Dobot Magician 

 

  (Optional) Set the homing point and make the nib contact the surface of the 

calibration board. 

This step is used for observing the nib position on the calibration board when moving 

J1-axis in Step 5, to improve calibration accuracy. 

 Click Teaching&Playback on the DobotStudio page. 

The Teaching&Playback page is displayed. 

 Press the Unlock key on the Forearm and drag Dobot Magician to make the nib 

contact the surface of the calibration board, then release the Unlock key. 

The coordinates of this point will be displayed on the Teaching&Playback 

page. 

 Select this point and right-click SetHome, as shown in Figure 5.154. 

  

Figure 5.154  Set homing position 
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 Click Setting > Base Calibration on the DobotStudio page. 

 Click Next on the Base Calibration page. 

Dobot will start homing. Please ensure that there are no obstacles in the workspace 

during homing. 

 Click +J1 or -J1 to make the nib at a point on the line between A3 and B3 on the 

calibration board, as shown in Figure 5.155 and Figure 5.156. 

If the speed is too fast when moving J1-axis, you can drag Speed slider to adjust 

speed. 

 

Figure 5.155  Move J1-axis 

 

 

Figure 5.156  Nib position 
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 Click Calibration to start calibrating the base Encoder. 

You can check the J1-coordinate on the Operation Panel page, as shown in Figure 

5.157. 

 

Figure 5.157  J1-coordinate 

 

 Sensor Calibration 

The angle sensors of the Forearm and Rear Arm have been calibrated before being shipped out. 

Generally, the Z-coordinate will remain the same when moving Dobot Magician in the same 

horizontal plane. If changed, you need to recalibrate the angle sensors by manual levelling or auto 

levelling to improve the positioning accuracy. 

 Manual Levelling: It is more accurate to calibrate manually with DobotStudio, sensor 

calibration board, and writing kit, which is suitable for the application scenarios with high 

requirements for absolute positioning accuracy. 

 Auto Levelling: It is simple and quick to calibrate automatically with DobotStudio and 

auto-levelling tool, which is suitable for the application scenarios without high 
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requirements for absolute positioning accuracy, such as writing and drawing, 3D printing. 

5.10.2.1 Manual Levelling 

Prerequisites 

 Dobot Magician has been powered on. 

 Dobot Magician has been connected to DobotStudio successfully. 

 The sensor calibration board has been prepared. 

Procedure 

 Place the Dobot Magician at the right position on the sensor calibration board, as 

shown in Figure 5.158. 

 

Figure 5.158  Location of Dobot Magician 

 

 Click Setting > Manual Levelling on the DobotStudio page. 

The Manual Levelling page is displayed. 

 Click Next on the Manual Levelling page. 

NOTICE 

Please remove all end-effectors from Dobot Magician before calibrating 
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Figure 5.159  Get the angle sensor coefficients 

 

 Click Next and set Angle Precision, Distance Precision, Result Range. 

 

Figure 5.160  Set precisions 

 

 Click Next and follow the instructions on the Manual Levelling page to move Dobot 

Magician to the first calibrated point. If the calibrated point is A3 on the Calibration 

board. 
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 Install the writing kit. For details, please see 5.4.1 Installing a Writing Kit. 

 Press the Unlock key on the Forearm and drag Dobot Magician to make the nib 

near the A3 point on the calibration board, then release the Unlock key. 

 Click coordinate buttons on the Manual Levelling page (as shown in Figure 

5.161) to make the nib align to the center of A3 point on the calibration board, 

as shown in Figure 5.162. 

If the speed is too fast when clicking coordinate buttons, you can drag Speed 

slider to adjust speed. 

 

Figure 5.161 Fine-tune page 

 



                     Dobot Magician User Guide 5 Operation 

Issue V1.0 (2018-06-12) User Guide Copyright © Yuejiang Technology Co., Ltd. 

 133  

 

Figure 5.162  Nib position 

 

 Click Next and follow the instructions on the Manual Levelling page (as shown in 

Figure 5.163) to move Dobot Magician to make the nib in the center of the second 

calibrated point. If the calibrated point is B3 on the calibration board, as shown in 

Figure 5.164. 

NOTICE 

Please DO NOT drag Dobot Magician in this step, to avoid manual levelling failure. If 

the speed is too fast when clicking coordinate buttons, you can drag Speed slider to adjust 

speed. 
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Figure 5.163  Fine-tune page 

 

 

Figure 5.164  Nib position on the second calibrated point 

 

 Click Next and set the distance between the two calibrated points, as shown in Figure 

5.165. 

The distance between the two calibrated points on the Calibration board is 80mm, so 

please keep the default value in this step. 
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Figure 5.165  Set the distance between the two calibrated points 

 

 Click Next to start calibrating. 

The result is shown as Figure 5.166. 

 

Figure 5.166  Calibrating result 
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5.10.2.2 Auto Levelling 

Prerequisites 

 Dobot Magician has been connected to a PC via USB cable. 

 Dobot Magician has been connected to the power adapter. 

 The auto-levelling tool has been obtained, as shown in Figure 5.167. 

 

Figure 5.167  Auto-levelling tool 

 

Procedure 

 Place Dobot Magician on the flat platform. 

NOTICE 

Please ensure that the platform is flat. Or, the auto levelling will be failed. 

 

 Fix the auto-levelling tool on the Dobot Magician with butterfly nut, as shown in 

Figure 5.168. 
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Figure 5.168  Fix auto-levelling tool 

 

 Insert the cable of the auto-levelling tool to the interface 1 on the Forearm, as shown 

in Figure 5.169. 

 

Figure 5.169  Insert the cable of the auto-levelling 
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 Power on Dobot Magician and connect it to DobotStudio. 

 Click Setting > Auto Levelling on the DobotStudio page. 

NOTICE 

Please ensure that there are no obstacles in the workspace during auto levelling. 

 

Figure 5.170  Auto levelling page 

 

 Click Start on the Auto Levelling page. 

NOTE 

If the auto levelling is failed, please check if the platform is flat and try again. 
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Figure 5.171  Auto levelling result 

 

 Homing 

Dobot Magician has been calibrated before being shipped out. If the Dobot Magician has been 

hit or the motor has lost step, leading data abnormal, you need to operate homing to improve the 

positioning accuracy. 

Prerequisites 

 Dobot Magician has been powered on. 

 Dobot Magician has been connected to DobotStudio successfully. 

Procedure 

Click Home on the DobotStudio page, as shown in Figure 5.172. 

NOTICE 

 Please remove the end-effector from the Dobot Magician before homing. 

 Please ensure that there are no obstacles in the workspace during homing. 

 

 

Figure 5.172  Operate homing 

 

Dobot Magician will rotate clockwise to the limited position and then return to the default 

homing point automatically and the LED indicator on the base turns blue and is blinking. After the 
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homing is successful, there is a beep sound and the LED indicator turns green. 

Also, the homing point can be use-defined, you can select a saved point on the 

Teachong&Playback page and right-click SetHome to set this saved point as the homing point, as 

shown in Figure 5.173. 

 

Figure 5.173  Set homing point 

 

 Connecting with WIFI Kit 

You can connect Dobot Magician to a PC via WIFI kit without USB cable, making Dobot 

Magician and PC in the same WLAN. Figure 5.174 shows the WIFI kit. 

 

Figure 5.174  WIFI kit 

 

Prerequisites 
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 Dobot Magician has been connected to a PC via USB cable. 

 Dobot Magician has been connected to the power adapter. 

 The WIFI name and password have been obtained and must be the same as that of PC. 

Procedure 

 Connect the WIFI kit to the UART interface on the base, as shown in Figure 5.175. 

 

Figure 5.175  Connect with WIFI kit 

 

NOTICE 

Please turn off the Dobot Magician completely first before connecting or disconnecting 

external equipment. Or, it causes serious damage to your device 

 

 Press down the power button to turn on the Dobot Magician. 

After turning on, there are two short beep sounds and the blue LED indicator on the 

WIFI module is on. 

 Select the corresponding serial port from the serial drop-down list, and click 

Connect. 

 Click Setting > Wi-Fi. 

The Set Dobot Wi-Fi page is displayed. 

 Set the related parameters on the Set Dobot Wi-Fi page. 

If you unselect Dynamic Host Configuration Protocol (DHCP), you need to set IP 
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address, Netmask, Gateway. For details, please see Table 5.17. 

 

Figure 5.176  Set WIFI 

 

Table 5.17  Parameter description 

Parameter Description 

SSID Set WIFI name 

The WIFI name and password have been obtained and must be the same as 

that of PC 

Password Set WIFI password 

Dynamic Host Configuration 

Protocol (DHCP) 

Whether to select DHCP 

Yes: Only set SSID and Password 

No: Only set IPAddress, Netmask and Gateway 

IPAddress Set the IP address of Dobot Magician. The IP address of Dobot Magician and 

the PC must be in the same WLAN without conflict. 

Netmask Set subnet mask 

Gateway Set gateway 

DNS Set DNS 
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 Click OK. 

About 5 seconds later, the green LED indicator on the WIFI module is on, indicating 

that the Dobot Magician has been connected with WLAN, as shown in Figure 5.177. 

 

Figure 5.177  Status of LED indicator 

 

 Click Disconnect on the left pane of the DobotStudio page. 

 After 2 seconds later, select the IP address from the drop-down list on the upper left 

pane of the DobotStudio page and click Connect, as shown in Figure 5.178. 

 

Figure 5.178  IP address of Dobot Magician 

 

After the connection is successful, you can control Dobot Magician without USB 

cable. 

 Connecting with Bluetooth Kit 

Dobot Magician can be connected to smart phone with Bluetooth. Figure 5.179 shows the 

Bluetooth kit. Please download the matched DobotStudio APP from the website 

https://www.dobot.cc/downloadcenter.html?sub_cat=69#sub-download. 

https://www.dobot.cc/downloadcenter.html?sub_cat=69#sub-download
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Figure 5.179  Bluetooth kit 

 

Prerequisites 

 Dobot Magician has been connected to the power adapter. 

 The DobotStudio APP has been downloaded. 

Procedure 

 Connect the Bluetooth kit to the UART interface on the base, as shown in Figure 

5.180. 
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Figure 5.180  Connect with Bluetooth kit 

 

NOTICE 

Please turn off the Dobot Magician completely first before connecting or disconnecting 

external equipment. Or, it causes serious damage to your device. 

 

 Press down the power button to turn on the Dobot Magician. 

After turning on, there are three short beep sounds and the blue LED indicator on the 

Bluetooth module is on and the green one is blinking. 

Turn on the Bluetooth and launch DobotStudio APP on your phone. And click 

Connect to connect with Dobot Magician. 

This topic only describes how to connect Bluetooth kit. For details how to operate 

Dobot Magician with DobotStudio APP, please see 

https://www.youtube.com/watch?v=kyeXwuf17IY. 

 Operating Blockly 

Blockly is a programming platform based on Google Blockly. You can program through the 

puzzle format, which is straightforward and easy to understand.  

Prerequisites 

https://www.youtube.com/watch?v=kyeXwuf17IY
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 Dobot Magician has been powered on. 

 Dobot Magician has been connected to DobotStudio successfully. 

Procedure 

 Click Blockly on the DobotStudio page. 

The Blockly page is displayed. 

 Drag the blockly module on the left pane of the Blockly page to program, as shown 

in Figure 5.181. 

 

Figure 5.181  Blockly graphic programming 

 

Table 5.18 lists the description of blockly module. 

Table 5.18  Blockly description 

No. Description 

1 The selection area of blockly module, including 

logistic, loop, math, and Dobot API. You can program 

by dragging them to the window. 

2 The window of blockly programming 

3 The running log of Dobot Magician 

4 The corresponding codes of the blockly module on the 

programming window 

 

The demo in Figure 5.181 is described as follows. 

 Set the end-effector as Gripper. 

 Set the loop number as 3 and make the Z-axis move back and forth 3 times. 

 Set the pause time as 3. 

 Click Save on the Blockly page. 

The Saving Blockly file page is displayed. 

 Input the use-defined name and the saving path, and click Save. The default path of 
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the programing file is Installation directory/DobotStudio/config/bystore. Please 

replace the path based on site requirements. 

 Click Start on the Blockly page, and Dobot Magician will move according to the 

program. 

 

 Scripting 

You can control Dobot Magician over scripting. Dobot Magician supports various API, such 

as velocity/acceleration setting, motion mode setting, and I/O configuration, which uses Python 

language for secondary development. For details about the Dotob Magician API interface and 

function description, please see Dobot Magician API Description.  

The download path is https://www.dobot.cc/downloadcenter.html?sub_cat=72#sub-download. 

Prerequisites 

 Dobot Magician has been powered on. 

 Dobot Magician has been connected to DobotStudio successfully. 

Procedure 

 Click Script on the DobotStudio page. 

The Script page is displayed. 

 Write a script. 

You can call the interface by double-clicking on the left pane of the Script page, the 

corresponding interface will be displayed on the middle pane, as shown in Figure 

5.182. You can also click  icon of the corresponding interface to view the way 

how to set the parameters. The scripting examples (including Jog, PTP, and Pallet) 

can refer to Installation directory/DobotStudio/config/ststore/. 

 

Figure 5.182  Write a script 

 

 Click Save on the Script page. 

https://www.dobot.cc/downloadcenter.html?sub_cat=72#sub-download
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The Saving Scrip File page is displayed. 

 Input the use-defined name and the saving path, and click Save. 

 Click Start, and Dobot Magician will move according to the script file. 

The running log will be displayed on the lower pane of the Script page for checking. 

 

 Operating Stick Controller Kit 

Dobot Magician can be controlled by stick controller kit without DobotStudio. Figure 5.183 

shows the stick controller kit. From left to right: Stick controller, USB Host module, USB cable 

(used for charging stick controller), Transceiver. 

 

Figure 5.183  Stick controller kit 

 

Prerequisites 

 Dobot Magician has been connected to a PC over USB cable. 

 Dobot Magician has been connected to the power adapter. 

Procedure 

 Connect the transceiver to the USB module. 

 Connect the USB Host module to the UART interface on the base, as shown in Figure 

5.184. 
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Figure 5.184  Connect with USB Host module 

 

 Press down the power button to turn on the Dobot Magician. 

NOTICE 

Please turn off the Dobot Magician completely first before connecting or disconnecting 

external equipment. Or, it causes serious damage to your device. 

 

 Press down the power button on the stick controller, as shown in Figure 5.185. 

The red LED indicator on the middle of the stick controller is blinking, indicating 

that the Dobot Magician can be controlled by the stick controller. 
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Figure 5.185  Power button of the stick controller  

 

Table 5.19 lists the functions of buttons on the stick controller. 

Table 5.19  Button function 

Button Function 

Power button Turn on stick controller 

The stick controller will turn off automatically 

LT Turn on the peripheral motor 

RT Turn off the peripheral motor off 

RB Switch to Cartesian coordinate system mode 

LB Switch to Joint coordinate system mode 

X Control the outtake of the air pump 

Y Control the intake of the air pump 

B Turn off the air pump 

Left stick: Front/back  Cartesian coordinate system mode: Dobot 

Magician moves along X-axis in the 

positive/negative direction 

 Joint coordinate system mode: Dobot Magician 

rotates along J1-axis in the 

positive/negative direction 

Left stick: Left/right  Cartesian coordinate system mode: Dobot 

Magician moves along Y-axis in the 
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Button Function 

positive/negative direction 

 Joint coordinate system mode: Dobot Magician 

rotates along J2-axis in the 

positive/negative direction 

Right stick: Front/back  Cartesian coordinate system mode: Dobot 

Magician moves along Z-axis in the 

positive/negative direction 

 Joint coordinate system mode: Dobot Magician 

rotates along J3-axis in the 

positive/negative direction 

Right stick: Left/right  Cartesian coordinate system mode: Dobot 

Magician rotates along R-axis in the 

positive/negative direction 

 Joint coordinate system mode: Dobot Magician 

rotates along J4-axis in the 

positive/negative direction 

 

 Operating Sliding Rail 

When the workspace of Dobot Magician is not enough, you can extend it with the sliding kit 

to do large-scale tasks, such as long-distance picking and placing, a large range of writing and so 

on. Figure 5.186 shows the sliding rail kit and Table 5.20 lists its description. 
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Figure 5.186  Sliding rail kit 

 

Table 5.20  Sliding rail kit description 

No. Description 

1 Tool kit 

2 Screws  

3 Plate a 

4 Plate c 

5 Sliding rail (with wire set and plate b) 

 

 Installing sliding rail 

Procedure 

 Mount Dobot Magician on the plate a with four M3*10 countersunk head cap screws 

(The counter bore of plate a is outwards), as shown in Figure 5.187. 
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Figure 5.187  Fix plate a 

 

 Fix the plate a (with Dobot Magician) on the plate b with three M3*8 hexagon socket 

head cap screws. Please make the back of the base of Dobot Magician towards the 

rabbet on the plate b, as shown in Figure 5.188. 
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Figure 5.188  Fixed position with screws 

 

 Connect the end of the wire set to its male connector, as shown in Figure 5.189. 

 

Figure 5.189  Connect with wire set 

 

 (Optional) Fix plate c. This step is only needed when using air pump for picking and 

placing or other tasks. 

 Fix the plate c on the plate a with two M3*8 hexagon socket head cap screws, 
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as shown in Figure 5.190. 

 

 

Figure 5.190  Fix plate c 

 

 Fix the air pump on the plate c, as shown in Figure 5.191. And connect the air 

pump to Dobot Magician. For details, please see 5.2.1 Installing a Suction Cup 

Kit.  

 

Figure 5.191  Fix air pump 

 

 Connect the interfaces on the end of the wire set to Dobot Magician, as shown in 

Figure 5.192. 
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Figure 5.192  Connect to Dobot Magician 

 

 Connect the interfaces on the other end of the wire set to the power adaptor, USB 

interface of PC, motor interface and homing interface of the sliding rail respectively. 

Figure 5.193 shows the interfaces on the other end of the wire set. 

 

Figure 5.193  Interfaces on the other end of the wire set 

 

Figure 5.194 shows the connection between the sliding rail and the wire set. 
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Figure 5.194  Connect sliding rail and wire set 

 

 Sliding Rail Parameter Description 

Table 5.21  Sliding rail parameter description 

Parameter Description 

Maximum payload 5kg 

Maximum Distance 1000mm 

Maximum speed 150mm/s 

Maximum acceleration 150mm/s2 

Repeated positioning accuracy 0.01mm 

Absolute positioning accuracy 0.25mm 

 

 Demo Description 

This topic describes how to use sliding rail for writing. 

Prerequisites 

 The sliding rail has been installed and connected to the Dobot Magician. 

 Dobot Magician has been powered on. 

 Dobot Magician has been connected to DobotStudio successfully. 

 The writing kit has been installed. For details, please see 5.4.1 Installing a Writing Kit. 
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Procedure 

 Click LineraRail on the DobotStudio page. 

Now, you can click L+, L- to make Dobot Magician move to the left or right. 

 Click Home on the DobotStudio page. 

The sliding block moves to its homing point and then Dobot Magician rotates back 

to its homing point. 

  (Optional) Save points on the Teaching&Playback page, so as to trigger them for 

some operations when Dobot Magician moves on the sliding rail, such as inking 

brush during writing. 

For details about teaching and playback, please see 5.2 Performing Teaching & 

Playback Tasks.  

 Click Teaching&Playback on the DobotStudio page. 

The Teaching&Playback page is displayed. 

 Save points on the Teaching&Playback page.  

The saved points list is as shown in Figure 5.195. 

 

Figure 5.195  Save points 

 

L indicates the position where Dobot Magician is located on the sliding rail, and 

the speed and acceleration can be set on the Setting > Playback page.  

 Click Exit to close Teaching&Playback page. 

 Click Write&Draw on the DobotStudio page. 

The Write&Draw page is displayed, as shown in Figure 5.196. 

For details about writing and drawing, please see 5.4 Writing and Drawing. 
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Figure 5.196  Write&Draw page 

 

The rectangle in Figure 5.196 is the workspace of Dobot Magician (with sliding rail). 

 Input text on the Iput Texts pane and click OK, as shown in Figure 5.197. 

If the text is Magician. 

 

Figure 5.197  Input text 

 

 (Optional) Right-click Add a playback trigger on the Write&Draw page to set 

trigger points, as shown in Figure 5.198. 
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Figure 5.198  Set trigger point 

 

If the trigger points are set after the first letter a and the letter c, as shown in Figure 

5.199. 

  

Figure 5.199  Trigger lines 

 

 Click Start. 

Dobot Magician starts writing. Take the first trigger point as an example, after writing 

the first letter a, the saved points list on the Teaching&Playback page is triggered, 

and Dobot Magician moves to the set position to perform the related operations 

according to the saved points list. Then, Dobot Magician continues to write. 

 

 Multiplexed I/O Demo 

The addresses of the I/O interfaces in Dobot Magician are unified. Most of I/O interfaces have 

multiple functions. For details, please see 4.3 Multiplexed I/O Interface Description.  

You can set I/O interfaces on the advanced Teaching&Playback page to control the peripheral 

equipment, as shown in Figure 5.200. 
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Figure 5.200  I/O setting page 

 

Now, demos of level output, level input, and PWM output are given below. 

 Level Output 

Normally, air pump can be controlled by the I/O interfaces. The I/O 11 controls its intake (High 

level) and outtake (Low level) and the I/O 16 controls its start-stop. Table 5.22 lists the multiplexed 

descriptions of I/O 11 and I/O 16. 

Table 5.22  Multiplexed I/O description 

I/O addressing Voltage Level Output PWM Level Input ADC 

11 3.3V √ √ √ - 

16 12V √ - - - 

 

The I/O 11 and I/O 16 are located at the peripheral interface of the base, as shown in Figure 

5.201. 
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Figure 5.201  Peripheral Interface on the base 

 

Prerequisites 

 The air pump has been connected to Dobot Magician. For details, please see 5.2.1 

Installing a Suction Cup Kit. 

 Dobot Magician has been powered on. 

 Dobot Magician has been connected to DobotStudio successfully. 

Procedure 

 Select Pen from the end-effector drop-down list on the DobotStudio page, as shown 

in Figure 5.202. 

Figure 5.202  Select end-effector 

 

NOTICE 

Normally, If SuctionCup or Gripper is selected from the end-effector drop-down list 

after the air pump has been connected, the air pump will be controlled by the system. In 
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this topic, we use I/O interfaces to control the air pump, so SuctionCup and Gripper 

cannot be selected, to avoid conflict. 

 Click  icon on the Teaching&Playback page, as shown in Figure 5.203. 

 

Figure 5.203  Switch advanced function 

 

 Select IO_11, IO_16 and their corresponding Value on the Output pane, and click 

+Point. 

“The saved point is displayed on the Teaching&Playback page, as shown in Figure 

5.204. 

NOTE 

If the intake is not obvious, please modify PauseTime of this saved point. 

 

Figure 5.204  Saved point 

 

 Select this point and click StepRun. 

The air pump is humming with intake. 

 Select IO_11, IO_16 and the corresponding Value of IO_16 on the Output pane, and 

click +Point. 

The saved point is displayed on the Teaching&Playback page, as shown in Figure 

5.205. 
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Figure 5.205  Saved point 

 

 Select this point and click StepRun. 

 Level Input 

This topic also takes I/O 11 as an example.  

Table 5.23  Multiplexed I/O description 

I/O addressing Voltage Level Output PWM Level Input ADC 

11 3.3V √ √ √ - 

 

Prerequisites 

 Dobot Magician has been powered on. 

 Dobot Magician has been connected to DobotStudio successfully. 

 The saved points list has been existed on the Teaching&Playback page. 

Procedure 

 Click  icon on the Teaching&Playback page, as shown in Figure 5.206. 

 

Figure 5.206  Switch advanced function 

 

 Select a saved point on the Teaching&Playback page. 

 Select EIO11_Input on the Trigger pane, and set Condition and its Value.  
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 Click ADD, as shown in Figure 5.207. 

 

Figure 5.207  Saved point 

 

 PWM OUTPUT 

This topic also takes I/O 11 as an example. 

Table 5.24  Multiplexed I/O description 

I/O addressing Voltage Level Output PWM Level Input ADC 

11 3.3V √ √ √ - 

 

Prerequisites 

 Dobot Magician has been powered on. 

 Dobot Magician has been connected to DobotStudio successfully. 

Procedure 

 Click  icon on the Teaching&Playback page, as shown in Figure 5.208. 

 

 Select IO_11 on the Output pane, and click +Point, as shown in Figure 5.209. 
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Figure 5.209  Saved point 

 

 Double-click EIO11 cell and select … from the drop-down list. 

The EIO Setting page is displayed, as shown in Figure 5.210. 

 

Figure 5.210  EIO setting 

 

 Set Frequency (Unit: KHZ; Value range: 10HZ-1MHZ) and DutyRatio (0%-100%) 

on the EIO Setting page. 
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